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About the Submittal Module
The Submittal module helps the project team actively manage the full submittal process, confirming that the 
contractor's planned work on the job site will meet the designer's  intentions as detailed in the project spe-
cifications. This module has streamlined the process to make it easy for subcontractors, general contractors 
(GC), submittal coordinators and design reviewers to collaborate within a single system.

E-Builder's submittal coordinator position can be assigned to various roles, often an architect/ engineer or the 
owner's project manager. The flexibility of the submittal coordinator position enables them to grant respons-
ibility to the correct team members based on each project's contractual requirements.

Both e-Builder licensed and non-licensed participants can be engaged in the submittal process and still work 
directly in the e-Builder system. The full team has access to the module appropriate to their needs in order to 
obtain status updates, view audit trails and identify bottlenecks at any phase of the project.

Ball-in-Court Mechanism

Like most e-Builder modules, Submittals utilizes the 'ball-in-court' mechanism to keep participants abreast of 
items awaiting their response. Automated email notifications alert participants when action is needed on their 
part. 

To support cross-functional visibility, a clearly defined 'Held By'  column is displayed for each Submittal Item vis-
ible on the Home page, and this data is available for inclusion in reports. The 'Held By' field lists all participants 
whose court the item is currently in.

Process Management

When general contractors and subcontractors add items to the submittal register, they can describe and man-
age the project's submittals with standard and custom fields, target due dates, item statuses, actual dates and 
more.

These details provide many benefits for the management team.
 l The GC is able to streamline the process early on and put controls in place (due dates) to reduce lag 

and encourage accountability.
 l Contractors and submittal coordinators can track response times from the design team to ensure 

prompt responses and address unnecessary delays.
 l They can also identify which packages are late and who's holding the process up to proactively address 

potential bottlenecks.

Throughout every phase of the submittal process, the submittal module facilitates the exchange of information, 
tracks transactions, and provides real-time visibility into the status of each submittal item. Submittal reports 
based on the logs provide real-time visibility and an opportunity to identify problem areas early on to mitigate 
potential risks.

The Submittal Workflow
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The diagrams below are a high-level view of the submittal workflow and its key players. These workflows illus-
trate the permission structure that allows both the general contractor and submittal coordinator to engage 
external participants while maintaining control and visibility of the entire process.

Image 1 - Forward flow of submittals

Image 2 - Return flow of submittals

Access Submittals
The Submittal module provides access to project-specific submittals. 

To access the Submittal module
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 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 

Note: If the submittal settings for the project have been configured already, the Submittal Register 
page is displayed. Otherwise the Submittal Settings page is displayed.

To access the Submittal Register page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 

Note: If submittal settings have not been completed, the Submittal Settings page is displayed; oth-
erwise, clicking Submittals from the Project Menu will open the Submittal Register page. For 
instructions on configuring submittal settings, see Complete Submittal Settings.

To access the Submittal Item Details page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 
 3. Click the title of a submittal item to view its details. The Submittal Item Details page is displayed for 

the selected item.

To access the Submittal Packages page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 
 3. From the Project Menu, click Submittal Packages.

To access the Submittal Package Details page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 
 3. From the Project Menu, click Submittal Packages.

 4. Click the title of a submittal package to view its details. The Submittal Package Details page is dis-
played for the selected package.

Submittal Register Page 
The Submittal Register page allows all participants of the submittal process to access submittal items and take 
the appropriate actions. The action buttons are permissions based, and therefore may not be available to all 
team members.

From the Submittal Register page you can take any of the following general actions:
 l Filter Submittal Items: The top portion of this page is a filter that allows you to narrow the list of sub-

mittals you are viewing by a wide range of criteria. 
 l View Filtered Submittal Items:              The table located in the lower portion of the page lists all available sub-

mittal items or the results of your filtered criteria. 

#submittal_packages_details_ove.htm
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Note: When the View draft submittals account-level setting is enabled, all team members who have 
the View Submittals permission will be able to see Submittal Register Items that are in Draft status.

From the Submittal Register page, the following role-specific actions can be taken to complete the submittal 
process:

 l General Contractor Tasks
 l Subcontractor Tasks
 l Submittal Contractor Tasks
 l Reviewer Tasks

To access the Submittal Register page
 l Open the Submittal module.

Note: If submittal settings have not been completed, the Submittal Settings page is displayed; oth-
erwise, clicking Submittals from the Project Menu will open the Submittal Register page. For 
instructions on configuring submittal settings, see Complete Submittal Settings.

Filter Submittal Items
The Filter Submittal Items section allows you to narrow down the results list to just the submittal items you 
need to view. This filter can be collapsed to increase screen real estate, and then expanded if necessary, by 
clicking the expand / collapse button in the upper-left corner of the page.

A description of the fields and buttons located in this section is provided below:

Filter Submittal Items
 l Search In: Select one of the following options to specify the search criteria.

 o All: Select this option to filter for all submittal items.
 o Pending my review: Select this option to search for only those submittal items that are 

pending your review. This is the default display if there is at least one item requiring your 
approval within the selected project.

 l Title: Enter the title of a specific submittal item to filter by.
 l Status: From the drop-down list, choose a specific submittal status to filter by.
 l Number: Enter a specific submittal item number to filter by.
 l Revision: Enter a specific submittal item revision number to filter by.
 l Submittal Package #: Enter a submittal package number to filter by items located in a specific 

page. You can filter on any part of the package number.
 l Responsible Sub/ Manufacturer: Enter the name of a sub-consultant or manufacturer to filter by.
 l Item Status: Select one or more of the following options to filter by submittal item status.

 o Open: Select this option to filter for open submittal items, which are those that have been 
added to a submittal package.

 o Closed: Select this option to filter by closed submittal items.
 o Draft: Select this option to filter by draft submittal items.
 o Overdue: Select this option to filter by overdue submittal items.

submittal_settings_page.htm
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 l Description: Enter text included in the description of a specific item(s) to filter by.
 l Category: From the drop-down list, select a specific category of submittal items to filter by.
 l Priority: From the drop-down list, select a specific priority of items to filter by.
 l Spec Section: Enter the spec section to filter by. The spec section refers to a section number in the 

specifications which itemizes the details of that section; such as Masonry, for example. This is usu-
ally based on the CSI division.

 l Sub Section: Enter the sub section to filter by. The sub section refers to the subsection number of 
the specifications which itemizes the details of that section. This is usually based on the CSI division 
and its spec section.

 l Reviewer: Enter the name of a specific review to filter by items reviewed by a particular person.
 l Clear: Click this button to clear the filters.
 l Filter: Click this button to filter by the entered criteria.

View Filtered Submittal Items
A description of the fields and buttons located in this section is provided below:

 l Priority Icons:  If applicable, this column displays the status of each item. Below is a description of 
each item: 

 o  High Priority

 o  Low Priority

 l Item Details: The paper clip and comment icons give you the options to view existing attachments and 
comments and add new ones. The calendar icon appears for general contractors (users with Add/Edit 
Submittal permissions). Click the calendar icon to view and modify submittal date details.

 l Title: Displays the title of the submittal item. Click to open the Submittal Item Details page. If available, 

the description icon appears ( ) - click to view a description of the item as entered by the general con-
tractor.

 l #: Displays the submittal item number.
 l Rev #: Displays the submittal item's revision number.
 l Package #: Displays the submittal package number that the items belongs to. If a number does not dis-

play, the item has not yet been added to a package.
 l Spec Section: Displays the spec section number. The spec section refers to a section number in the 

specifications which itemizes the details of that section; such as Masonry, for example. This is usually 
based on the CSI division.

 l Sub Section: Displays the sub section number. The sub section refers to the subsection number of the 
specifications which itemizes the details of that section. This is usually based on the CSI division and its 
spec section.

 l Category: Displays the category that the submittal item belongs to.
 l Status: Displays the status of the item as assigned by the submittal coordinator. Submittal statuses 

and prefixes are customizable by account administrators, therefore available statuses may vary. Below 

submittal_packages.htm
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is a description of the default statuses, which may or may not be used by your particular account:
 o App - Approved
 o AAN - Approved as Noted
 o FRO - For Record Only
 o ONH - On Hold
 o REJ - Rejected
 o REV - Revise
 o RAR -Revise & Resubmit

 l Submittal Coordinator: Displays the name of the submittal coordinator.
 l Held By: Displays the name of the person(s) who the item is currently in the court of.

 o General Contractor and Subcontractors: If the item was sent to a subcontractor, their name 
or email address (if an external subcontractor) will appear in this field. Internal subcontractors 
are able to send items to other subcontractors. If this occurs, and neither of these users have 
taken action on the item, both of their names will appear in this field.

 o Submittal Coordinator and Reviewers: If the item was sent for review by the submittal coordin-
ator to one or more reviewers, the name or email address (if an external reviewer) of those 
reviewers will appear in this field, as long as they have not yet taken action on the item.

 l Reviewers: A Reviewers link appears in this column when the item has been forwarded for review by 
the submittal coordinator or sub-consultants. Click this link to view a list of all reviewers of the item and 
if applicable, when their reviews were completed.

General Contractor Tasks
A General Contractor can take the following actions from the Submittal Register page:

 l Add Items 
 l Send Individual Items for Review
 l Send Items to Subcontractors
 l Add Items to Submittal Package
 l Delete Submittal Items
 l Import Submittal Register
 l Close Submittals
 l Revise Submittals

As a general contractor, you should have Add/Edit Submittal permissions, which will give you the ability to take 
the actions implied by each of command buttons listed below.

General Contractor Action Buttons
 l Send for Review: Click to send select items to the submittal coordinator for review. You can send 

an entire submittal package for review or the individual items of the package. 

Note: Submittal items must be part of a submittal package before they can be sent to the sub-
mittal coordinator for review.

Sending individuals items for review allows you to get the review process underway if all items that 

#close_submittal_package.htm
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belong to the package are not yet ready to be reviewed.    For instructions, see Send Individual Items 
for Review. When a submitter (General Contractor) clicks the Send for Review button on the Items 
tab of the Submittal Package Details page, the submittal item status will change from "NEW" to "In 
Review". 

 l Send to Sub: Click to send select items to a subcontractor. Subcontractors will receive an email 
notification with the details of the item(s). Both licensed and non-licensed e-Builder subcontractors 
will be able to respond, make comments and attach documents to the item(s), however, only 
licensed subcontractors will be able to send the item to another subcontractor for review. A history 
log of the item's trail is accessible from the submittal item's History tab.
 The subcontractor's name or email address (depending on whether they have an e-Builder user-
name or not) will be place in the Held By field on the Submittal Register page. When the sub-
contractor responds, the Held By field will be updated with the general contractor's name as the item 
will effectively be back in the GC's court. For instructions, see Send Items to Subcontractors.

 l Add to Package: Click to add select items to a new or existing submittal package. Only new status 
submittal items can be added to a package. For instructions, see Add Items to Submittal Package.

 l Add Item: Click to add an individual submittal item. Typically, the submittal log is imported at the 
onset, but it may be necessary to update the register with individual submittal items as the need 
arise. For instructions, see Add Individual Submittal Items.

 l Delete: Click to delete select items. Only draft items now associated to a package can be deleted. 
For instructions, see Delete Submittal Items.

 l Import: Click to import submittal items. The submittal register is typically imported by the general 
contractor at the start of the submittal process, but additional items via import whenever necessary. 
Additionally imported items will be appended onto the existing list of submittal items. For instruc-
tions, see Import Submittal Register.

Setup Tasks
Typically, the general contractor (GC) is responsible for setting up the Submittal module independent of the 
account settings. After account configurations are completed, it is the GC's obligation to complete a set of pre-
liminary tasks before the submittal review processes can get underway. These tasks are as follows:

 l Complete Submittal Settings
 l Assign Submittal Coordinator
 l Import Submittal Register

Complete Submittal Settings

About Project Submittal Settings

For the purpose of the Submittal module, the General Contractor (GC) function is determined by the Add/ Edit 
Submittal permission. This permission must be assigned in the Setup module to a specific GC user role by an 
account administrator.
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Once the add / edit permission has been assigned, users within that role have access to the project-level Sub-
mittal Settings page. The intention of giving the GC settings access is to allow the GC to manage much of the 
submittal process on individual projects independently from the owner's organization. Because the Submittal 
Settings can alter the workflow of the submittal reviews, the role(s) that are granted the add / edit permission 
should be carefully planned by the project team.

Note: Account administrators can also access the project Submittal Settings.

Complete the Project Submittal Settings

Verifying the project submittal settings is a necessary first step for general contractors when using the Sub-
mittal module. The Submittal Settings is the first page to display when accessing this module for the first time 
on a project, which gives you the opportunity to set the framework for how the submittal process will work for 
this particular project.

Many of the Submittal Settings are established as defaults at the account level by the administrator, but can be 
modified for each project's specific requirements. Project Submittal Settings can be edited at any time during 
the project.

Assigning a submittal coordinator for the project is required and very important. For details, see Assign Sub-
mittal Coordinator.

To complete submittal settings

 1. Open the Submittal module.
 2. From the Project Menu, click Settings.

The Submittal Settings page is displayed.

 3. Complete all necessary fields.

Note: For a description of each field, see Submittal Settings Page Overview.

 4. Click Save.

Assign Submittal Coordinator

The submittal coordinator role is the central traffic cop for the submittal review process and is often filled by the 
architect/ engineer on the project. If the project owner is directly involved in managing the submittals, this role 
may be assigned to the facilities project manager within the owner's organization. In any case, this assignment 
can vary depending on each project's team structure and contractual needs.

Projects can have multiple submittal coordinators, but each submittal item is assigned to a single submittal 
coordinator individual. Submittal coordinators are able to manage each other's submittal items in the event of 
an absence.

The General Contractor is responsible for assigning a submittal coordinator. This step is typically done as part 
of setting up the Submittals module for each project, along with completing other submittal settings.

Note: Submittal coordinators must be licensed e-Builder users with View Submittal permissions. The sub-
mittal coordinator does not typically have other submittal permissions unless they will also be performing 
functions normally handled by the subcontractors or general contractors.
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Tip
e-Builder recommends assigning at least two submittal coordinators per project to avoid bottlenecks.

To assign a submittal coordinator

 1. Open the Submittal module.
 2. From the Project Menu, click Settings.

The Submittal Settings page is displayed.

 3. In the Submittal Coordinator field, click the Select From drop-down arrow to narrow down the list of 
users to select from or choose All Roles.

 4. Select the user and then click the right directional arrow to add the user to the adjacent box.
 5. Click Save.

Tip
If you do not see the needed user in the selection list, verify with your e-Builder Administrator that 
the user meets all of the criteria below:

 l User is a member of the project
 l User is a member of the selected role
 l User has view submittal permissions

Related Topics:
 l Submittal Settings Page Overview

Import a Submittal Register

The submittal register is typically imported into e-Builder by the general contractor (with Add/ Edit Submittals 
permission) at the start of the submittal process. Imports can also be performed by subcontractors with the 
Create Submittal permission.

While submittal items can be added one at a time, the Excel file Import function allows you to save time by 
importing items in bulk. The import file can include as much or as little detail about the submittal items as 
necessary. If available, custom fields can also be imported. 

Submittal Register Import File Requirements
 l Supported import file types include .xls and .xlsx.
 l Header row values in the import file: 

 o The import file must have a defined header row for a successful import (highlighted in the 
image below).
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 o If the header row in the import file is identical to the e-Builder field names, these fields will be 
automatically populated, otherwise, you will have to click the drop-down arrows to map the 
columns in the import file to those in e-Builder. 

Example
The following image is of the Field Mappings page that is displayed after the file is 
uploaded. The left column lists the built-in e-Builder fields. The right column (with the 
drop-down menus) are the column names of the imported Excel spreadsheet. If the 
header row in the import file is identical to the e-Builder field names, these fields will be 
automatically populated, otherwise, you will have to click the drop-down arrows to map 
the columns in the import file to those in e-Builder.

To import the submittal register

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Click Import.

 3. Click Choose File to search for and select the import file.
 4. Click Next. The Field Mapping page is displayed showing the mapping between your Microsoft Excel® 

columns and the e-Builder fields.
 5. If the columns in your file are the same as the columns in e-Builder, they will populate automatically. If 

not, select the corresponding fields from the adjacent drop-down menus.
 6. Click Next. The Review page is displayed showing a preview of the import and any exceptions determ-

ined.
 7. If there were errors, review them on the Exceptions tab, make necessary changes, and then click Pre-

vious to re-import the spreadsheet. Repeat this procedure from step 3.
—Or—
If all rows have imported correctly, click Import. A import confirmation notification is displayed.

 8. Click Finish.

Related Topics:
 l Add a Single Submittal Item
 l Access the Submittal Module
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Add Individual Submittal Items
Submittal items can be added one-at-a-time, or if you have a list of the items prepared, you can import the 
Register using an Excel spreadsheet. If the package has already been created, the item can also be added by 
following the procedure below.

To add submittal items

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Click Add Item.

 3. Complete all required fields.
 4. Click Save.

Related Topics:
 l Import Submittal Register
 l Access Submittal Module
 l Submittal Register Page Overview

Add Individual Submittal Items

Submittal items can be added one-at-a-time, or if you have a list of the items prepared, you can import the 
Register using an Excel spreadsheet. If the package has already been created, the item can also be added by 
following the procedure below.

To add submittal items

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Click Add Item.

 3. Complete all required fields.
 4. Click Save.

Related Topics:
 l Import Submittal Register
 l Access Submittal Module
 l Submittal Register Page Overview

Edit Submittal Details

Note: A submittal item's details can be edited only if it has not already been sent to a submittal coordinator 
for review.

General contractors or anyone with add/ edit submittal permissions have the ability to make changes to the 
details of a submittal item except for target and actual dates, unless the account administrator has enabled this 
feature on the Submittal Settings page in the Setup module. See Allow Editing of System-Generated Dates for 
more detail.

submittal_settings_page.htm
system-generated_dates.htm
system-generated_dates.htm
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To edit the details of a submittal item

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Click the title of the item you want to edit. The Submittal Item Details page is displayed.
 3. Click Edit. The Edit Submittal Item page is displayed.
 4. Modify the values in the following editable fields as required:

 o Title
 o Description
 o Spec Section
 o Category
 o Responsible Sub/ Manufacturer
 o Priority
 o Sub Section
 o Commitment

 5. Click Save.

Related Topics:
 l Add/ Edit Submittal Item Page Overview

Delete Submittal Items

Submittal items can be deleted by general contractors or anyone with add/ edit submittal permissions.

Note: Only draft submittal items not associated to a package can be deleted. To delete an item in a pack-
age, which has not yet been sent for review, remove the item from the package first, and then delete it.

To delete submittal items

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Select the check box next to the item(s) you want to delete.
 3. Click Delete. 
 4. When prompted to confirm, click OK.

Send Items to Subcontractor

e-Builder has two primary methods of starting the review of a submittal item.

Note: Only items that have not yet been forwarded for review to the submittal coordinator can be sent to a 
subcontractor (Send to Sub).

Send to Sub

In this method, the GC establishes the project submittal register of planned submittals. The GC periodically 
requests submittal documentation from the assigned subcontractor as subcontracts are awarded using the 
Send to Sub action. The GC selects submittal items from the submittal register to Send to Sub. Items do not 
have to be in a package at this point. The subcontractor receives an email notification with the details of the 
item, including any attachments.
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Create / Submit to GC

In this method, subcontractors(with Create Submittal permissions) are directly participating in the submittal 
process, and are creating all or some of the submittal register items instead of the GC. The subcontractor uses 
the Create action, attaches documentation, and uses the Submit to GC action to start the review process. 

In this scenario, the Send to Sub action is not typically used as part of the review initiation. See Submit Items 
to GC.

Note: The Send to Sub action may also be used at the end of the review cycle for the GC to return a final 
submittal to the subcontractor. See Return Items to Subcontractor for more details.

Licensed and non-licensed e-Builder subcontractors who receive a Send to Sub item can add comments and 
attach documents to the submittal. Additionally, licensed subcontractors can in turn use the Send to Sub action 
to forward an item to a next tier subcontractor.

The subcontractor's name or email address appears in the Held By column on the Submittal Register page. 
When the subcontractor responds, the Held By field will be updated with the GC's name and the item returns to 
the GC's court.

To send submittal items to a subcontractor

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Select the check box next to the items you want to send to the subcontractor.
 3. Click Send to Sub. The Send Items to Sub dialog box is displayed.

Note: For a description of the fields on this page, see Send Items to Sub Page Overview.

 4. Enter all necessary fields.

Tip
 When emailing an external user that is also an e-Builder contact, use your keyboard to auto-fill the 
desired email address. Begin typing the recipient's name or email address, then use the arrows to 
highlight the email of choice, and then click Tab to make the selection.

 5. Click Send to Sub.

Update Submittal Item Dates

While entering submittal items into the system, either via import or individually, the general contractor will 
include the due dates and if applicable, the actual date details for the items. These details may change as the 
submittal process proceeds. 

It's important to be accurate about these dates, as reports can be run for these details to help the admin-
istrative team identify potential bottlenecks.

To update the dates for submittal items

 1. Open the Submittal Item Details page.
 2. Select the items for which you want to make date changes.
 3. Click Update Dates.
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 4. Make the necessary changes.
 5. Click Save.

Attach Documents to Submittals

In IE 10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your local dir-
ectory onto the Attached Documents tab. This can be done to attach documents throughout e-Builder Enter-
prise.

To attach documents to submittals

 1. Go to the Submittal Register page.
For instructions on how to access the Submittal Register page, see Access Submittals.

 2. In the Item Details section, click the paper clip icon for the submittal item to which you want to attach the 
document(s).
The Attached Documents - [Submittal Item Name] window appears.

 3. Click Add. The Attach File window is displayed.
 4. Select how you wish to attach the file. 

Tip: You can either add files from your computer to the e-Builder Documents module and then attach 
them, or attach an existing file from the Documents module.

 o Click Upload from your Computer to browse for files on your computer.

 i. Search for and select the e-Builder Destination Folder for the attachment. Click Select.
 ii. Drag and drop the file from your machine or click Browse to search for and select it.
 iii. Add a description for the file(s) being uploaded. Click Finish.

 o Click Select from Documents Module to attach files from  e-Builder.

 i. Select a file to attach from the left navigation pane. The selected files will be displayed on 
the right pane.

 ii. Select the check box beside the file name on the right pane. Click Attach.
 5. If document custom fields are enabled on the account, the Document Custom Fields page is displayed. 

Complete all the necessary fields, and then click Close.
 6. Optional: Optionally, you can take any of the following actions:             

 o Click the Download link to download the file.
 o For PDF and image files, click the Redline link to mark up the file.
 o For PDF documents, click the Stamp link to add a stamp to the file.

Related Topics:
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 l Submittal Register Page Overview

Create Submittal Packages
A submittal package is a collection of submittal items grouped together by the contractor to expedite the 
approval process. Individual submittal items cannot be sent to the submittal coordinator, only submittal pack-
ages can be exchanged between the general contractor and the submittal coordinator; however, if you dis-
cover that additional items need to be sent to the coordinator after the package has been sent, you can edit the 
package to include those items. If one item needs a response faster than the other items, it is recommended to 
send that item in its own package. The submittal coordinator should review and update the status of all items 
before submitting the package back to the contractor.

To create a submittal package

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Click Create Package.

The Create Submittal Package page is displayed.

 3. Enter all necessary fields.

Tip
When selecting the CSI Division, if you enter the first couple of numbers it will bring you down to that 
section.

 4. Click Save.
The Submittal Package Details page is displayed.

 5. Click Add Items.
The Add To Package submenu displays.

 6. Make one of the selections below, and then click Add.
 o Add existing items:

 a. The Add Items dialog box appears. Select the check box next to the item(s) you wish to 
add to the package.

 b. Click Add to Package.
 c. A confirmation dialog box appears. Click OK.

 o Add New items:
 a. The Add Submittal Item page appears.
 b. Enter all required fields.
 c. Click Save.

Create Submittal Packages

A submittal package is a collection of submittal items grouped together by the contractor to expedite the 
approval process. Individual submittal items cannot be sent to the submittal coordinator, only submittal pack-
ages can be exchanged between the general contractor and the submittal coordinator; however, if you dis-
cover that additional items need to be sent to the coordinator after the package has been sent, you can edit the 
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package to include those items. If one item needs a response faster than the other items, it is recommended to 
send that item in its own package. The submittal coordinator should review and update the status of all items 
before submitting the package back to the contractor.

To create a submittal package

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Click Create Package.

The Create Submittal Package page is displayed.

 3. Enter all necessary fields.

Tip
When selecting the CSI Division, if you enter the first couple of numbers it will bring you down to that 
section.

 4. Click Save.
The Submittal Package Details page is displayed.

 5. Click Add Items.
The Add To Package submenu displays.

 6. Make one of the selections below, and then click Add.
 o Add existing items:

 a. The Add Items dialog box appears. Select the check box next to the item(s) you wish to 
add to the package.

 b. Click Add to Package.
 c. A confirmation dialog box appears. Click OK.

 o Add New items:
 a. The Add Submittal Item page appears.
 b. Enter all required fields.
 c. Click Save.

Add Items to Submittal Packages

The general contractor will typically add items to a package after they've been reviewed by subcontractors; 
however, if you choose, you can add items to a package without a subcontractor's review. After items are 
added to a package, they can then be sent to the submittal coordinator for review.

To add items to a submittal package

 1. Go to the Submittal Register page.
For instructions, see Access Submittals.

 2. Select the check box next to the item(s) you want to add.

Note: Only draft items can be added to a package, which are those items that have not yet been 
updated by the submittal coordinator.
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 3. Click Add to Package. The Add To Package submenu displays and presents the two options listed 
below.

 4. To items to a new package, select the Create new submittal package radio button.
The Add Submittal Package page is displayed.
—Or—
To add items to an existing submittal package, select the Select existing submittal package radio but-
ton.

Note: If the setting, Allow items to be added after review starts is NOT enabled, you will not be able to 
select an existing package that includes items which have already been sent for review. See Sub-
mittal Settings Page Overview for details.

 5. Click Continue. This ends the task if you are adding to an existing package. Otherwise, go to the next 
step.

 6. Enter all necessary fields.
 7. Click Save.

Related Topics:
 l Submittal Register Page Overview

Generate Transmittals

A transmittal is a word document that summarizes the details of a submittal package. The name of the pack-
age, and a list of all submittal items the package is comprised of are listed in a transmittal. Details for each sub-
mittal item are also included such as item numbers, categories, statuses, and notes. If submittal mail merge 
template(s) have been assigned to the project, the transmittal will automatically render according to the tem-
plate on file. If more than one template it assigned to the project you will be prompted to make a choice.

A transmittal can be used in a number of ways. They are often used as a cover sheet when sending hard copy 
materials to the submittal coordinator. Optionally, a transmittal can also be attached to a submittal package 
before it's sent to the submittal coordinator to maintain a paper trail of physical materials.

To generate a transmittal

 1. Go to the Submittal module.
For instructions, see Access the Submittal Module.

 2. From the Project Menu, click Submittal Packages.
 3. Select a package.
 4. Click Generate Transmittal.
 5. If more than one Submittal mail merge templates is assigned to the project, you will be prompted to 

make a choice. Click the drop-down list and make a selection.

Related Topics:
 l Submittal Package Details Page Overview
 l Submittal Mail Merge Templates

#allowadditionpostreview
#allowadditionpostreview
mail_merge_submittals.htm
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Remove Items from Submittal Package

Team members may need to remove individual items from a submittal package that were incorrectly added. 

You may remove items ONLY if the following conditions apply:
 l The package is NOT in Closed status
 l The package is NOT in Approved status
 l The individual item is NOT approved
 l The individual item has NOT been sent for review
 l The individual item MUST reside in a package that is the most recent revision.

To remove items from a submittal package

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the package that you want to modify. The Submittal Package Details page displays.
 3. Select the check box next to the item(s) you want to remove.
 4. Click Remove Items. You are prompted for confirmation.
 5. Click OK.

Related Topics:

Submittal Package Page Overview
Submittal Package Details Page Overview

Send Submittal Package for Review

Sending the package for review places it in the submittal coordinator's court. General contractors can send 
either the entire submittal package for review or just the individual items of the package.

To send a submittal package for review

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the check box next to the package you want to send.
 3. Click Send for Review.

The Send for review dialog box displays.

 4. Enter all necessary fields.
 5. Click Send for Review.

Related Topics:
 l Send Individual Items for Review
 l Submittal Package Page Overview
 l Submittal Package Details Overview
 l Send for Review Page Overview
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Send Individual Items for Review

After items have been added to a submittal package, the general contractor can send either the entire sub-
mittal package for review or just the individual items of the package. Sending individuals items allow you to get 
the review process underway if all items that belong to the package are not yet ready to be reviewed.

To send individual packaged items for review

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the package that includes the items you want to send.

The Submittal Package Details page displays.

 3. Select the check box next to the item(s) you want to send.
 4. Click Send for Review. The item status will change to "In Review".

Return Item to Subcontractor

After the design review process is completed, the submittal coordinator will return the final reviewed submittal 
with attachments and comments to the general contractor (Add/Edit Submittal permissions). 

At this point, subcontractors with access to e-Builder will be able to view the final reviewed submittals returned 
by the submittal coordinator.  However, to ensure that the subcontractors realize that the submittal has been 
returned, the GC may want to use the Send to Sub action to send a notification. 

Additionally, if the subcontractor has Create Submittal rights, the GC may use the Send to Sub with an Action 
Required to request that the subcontractor create a revision for resubmittals.   

Tip: GCs can use the Send to Sub action on open items that they are holding.  If you are regularly notifying 
subcontractors of reviewed items, be sure the submittal register statuses are not using Auto-Close and 
bypassing the GC.   

To return submittal items to the subcontractor

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Click the package title. The Submittal Package Details page displays. 
 3. Select the item(s) to be returned. 
 4. Click Send to Sub and complete the form. 

 o Select Notify send type to simply let the subcontractor know that a submittal has been com-
pleted. 

 o Select Action Required send type for subcontractors with Create permission to ensure they cre-
ate a revision and resubmittal.  Identify a due date for the revision to be created. 

 5. Click Save. 

Related Topics:

Send Items to Sub Page Overview
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Revise and Resubmit Submittal Item

If the status of an item is revise and resubmit, the contractor must create a revision to the package to resubmit 
the items that have been requested. Once a revision has been created, the revised item(s) will automatically 
become their own package. When a revision package is created, the last number in the package number is 
updated to reflect the number of revisions to that package.

To review and resubmit submittal items

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Click the package title.

The Submittal Package Details page displays.

 3. Select the item(s) to be revised.
 4. Click Create Revision.
 5. Click Save.

The Submittal Package Details page displays.

 6. Optional: You can attachment documents by clicking the Attach link located on the results table.
 7. Start the submittal process over again.

Related Topics:
 l Add Attachments
 l Submittal Package Details Overview

Close Submittal Packages

If there are items that have been reviewed by the submittal coordinator and no additional revisions are needed, 
the contractor can close the item if they agree with the response. The contractor should create revisions for all 
items that need to be revised before closing out the completed items.

Note: If the setting Honor Auto-Close Status is enabled, then submittal items will automatically be placed in 
Closed status when the item is set to a specific status, which is predefined by the account administrator. This 
is an account and project-level setting. For more information, see  Submittal Register Options (Account Set-
ting) and Submittal Settings Page Overview (Project Setting)

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the package whose details you wish to view.

The Submittal Package Details page is displayed.

 3. Click Close.
You are prompted for confirmation.

 4. Click Continue.

Related Topics:
 l Submittal Package Details Overview

submittal_register_options.htm
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Subcontractor Tasks
A subcontractor can take the following actions from the Submittal Register page:

 l Add Items 
 l Add Items to Submittal Package
 l Delete Submittal Items
 l Import Submittal Register
 l Send Items to Another Subcontractor
 l Reply to Submittal Items
 l Close Submittals
 l Revise Submittals

e-Builder licensed subcontractors with View Submittal permissions can take the actions implied by each of 
command buttons listed below. Users with this permission setting are able to see all submittal items, even if 
they are not assigned to them. Non e-Builder-licensed subcontractors have the same privileges except for the 
ability to send items to another subcontractor.

Subcontractor Action buttons
 l Send to Sub: This button appears only for e-Builder licensed subcontractors. Click to send the sub-

mittal item to another subcontractor for review. This will effectively update the Held By field with the 
name or email address of the recipient; indicating that the item in now in their court. For instructions, 
see Send Items to Another Subcontractor.

 l Reply: Click to reply to the submittal item review request. This option only allows you to send a mes-
sage, but if necessary you can also attach documents to the submittal item and add comments. For 
instructions on replying, see Reply to Submittal Items.

Working with Submittal Items
e-Builder has two primary methods of starting the review of a submittal item:

 1. Send to Sub: The GC establishes the project submittal register of planned submittals. The GC peri-
odically requests submittal documentation from the assigned subcontractor as subcontracts are awar-
ded using the Send to Sub  action. See Send Items to Subcontractor.

 2. Create / Submit to GC: Subcontractors are directly participating in the submittal process, and creating 
all or some of the submittal register items instead of the GC. The subcontractor uses the Create action, 
attaches documentation, and uses the Submit to GC action to start the review process.

Subcontractors with Create Submittal permission can work with submittal items in a similar manner as general 
contractors with Add/Edit Submittal permission.

Subcontractors can only view draft submittal items that they created themselves, or that the GC has sent to 
them. If the GC creates a comprehensive register for the whole project (scenario 1 above), subcontractors will 
not be able to view these items until the GC requests documentation with the Send to Sub action.

All submittals must route through the GC using the Submit to GC action, and cannot be sent directly from the 
subcontractor to the submittal coordinator or design team.

#close_submittal_package.htm
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To work with submittal items, see the following pages:
 l Add Individual Submittal Items
 l Edit Submittal Details
 l Delete Submittal Items
 l Attach Documents to Submittals
 l Submit Items to GC
 l Add Comments to Submittal Items
 l Reply to Submittal Item 
 l Send Items to another Subcontractor 

Related Topics:
 l Import Submittal Register
 l Access the Submittal Module
 l Submittal Register Page Overview 

Submit Items to GC

After the subcontractor creates submittal items and attaches the documentation to be reviewed, the sub-
contractor can use the Submit to GC action to start the review process. The submittal items do not have to be 
in a package at this point.

The GC's name appears in the Held By column on the Submittal Register page, and in the GC's court until the 
item is forwarded to the submittal coordinator for review.

To submit submittal items to a GC

 1. Go to the Submittal Register page.
For instructions, see Access Submittal Register Page.

 2. Select the check box next to the item(s) you want to send to the GC.
 3. Click Submit to GC.

The Submit to GC dialog box displays.

Note: For a description of the fields on this page, see Submit to GC Page Overview.

 4. Enter all necessary fields.

Note: The General Contractor drop down list will contain a list of individuals for selection to receive 
the submittal item. If no names appear in the list, then the GC or project administrator needs to 
identify the GC role that will manage submittals in the project submittal settings page.

 5. Click Submit to GC.

Add Comments to Submittal Items

Users with View rights can add comments to a submittal item. Once they send the item to another resource, 
they can no longer add comments.
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Example: Submittal coordinators typically add comments and attachments while reviewing items between 
themselves and their reviewers. Once they send the item to the GC, they can no longer add comments.

Note: If the Hide Comments and Attachments feature is enabled on the account, comments and associated 
attachments will be hidden from the GC by default. To make individual comments visible, click the cor-
responding "Show" link. If a "Show" link does not appear, it's an indication that this feature is not set and all 
comments and attachments will be visible to the GC. 

To add comments to a submittal item

 1. Open the Submittal Item Details page.
 2. Click the Comments tab, and then Add Comments.

The Add Comments page is displayed.

 3. Enter comments.
 4. Optionally, you can attach documents to your comments by clicking Attach Documents.
 5. Click Save.

Related Topics:
 l Redline Submittal Documents
 l Stamp Submittal Documents
 l Reply to Submittal Items
 l Send Items to another Subcontractor

Reply to Submittal Item

Replying to the submittal item will send a message to the person that sent you the submittal item; this may be 
the general contractor or another subcontractor. After replying, your name will be removed from the Held By 
column and the item will no longer be in your court.

Tip: For more information on how reviewers can mark a review as complete, see Mark Reviews Complete.

To reply to submittal items

 1. Open the Submittal Item Details page.
 2. Click Reply.

The Reply Submittal Items dialog box displays.

 3. Enter a comment.
 4. If this option is available to you, select or clear the Private check box to make your comment either 

private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature allows 
only users in select roles to view and add private comments. For more information, see Manage Priv-
ate Comments.

 5. Click Reply.

Related Topics:

submittal_settings_page.htm
manage_private_comments.htm
manage_private_comments.htm
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 l Redline Submittal Documents
 l Stamp Submittal Documents
 l Send Items to another Subcontractor
 l Mark reviews complete

Send Items to another Subcontractor

Note: Only licensed e-Builder subcontractors are able to send items to another subcontractor.

You may need to send items to another sub for a second opinion or to solicit additional information. When the 
recipient replies, the message will be sent directly to you. A log of this action will be captured on the submittal 
item history tab. Additionally, the recipient's name or email address (for external subcontractors) will be added 
to the Held By column on the Submittal Register page, indicating that the item is currently in their court as well. 
When they reply, their name will be removed from this column, but will remain on the list of reviewers.

To send an item to another subcontractor

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Select the check box next to the item(s) you want to send to sub.
 3. Click Send to Sub.

The Send Items to Sub page displays.

 4. Complete all necessary fields.
 5. Click Send to Sub.

Related Topics:
 l Send Items to Sub Page Overview

Attach Documents to Submittal Items

You are able to attach files to a submittal item as long it is in your court. Once the item is sent off to another 
resource, you will not be able to add or edit attachment, but you will still be able to view any files that might be 
attached to the item.

Tip
In IE 10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your local 
directory onto the Attached Documents tab. This can be done to attach documents throughout e-Builder 
Enterprise.

To attach documents to a submittal item

 1. Open the Submittal Item Details page.
 2. Click the Documents tab, and then Attach Documents.

The Attach Documents dialog box appears.

 3. In the Select Attachment Method section, select your method of attachment.
 4. Click Browse For Files...
 5. Search for and select the file you want to attach.
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 6. If you are attaching files from e-Builder, go to step 9.
—Or—
If you are uploading files from your computer, in the Select an e-Builder Destination folder field, click 
Browse.

Note: Selecting a destination folder is only applicable if a default folder is not already assigned.

 7. Search for and select the e-Builder destination folder.
 8. Click Attach Selected.
 9. If document custom fields are enabled on the account, the Document Custom Fields page is displayed. 

Complete all necessary fields, and then click Close.
 10. Optionally, you can take any of the following actions:

 o Click the Download link to download the file.
 o For PDF and image files, click the Redline link to mark up the file.
 o For PDF documents, click the Stamp link to add a stamp to the file.

Related Topics:
 l Redline Submittal Documents
 l Stamp Submittal Documents
 l Add Comments to Submittal Documents
 l Reply to Submittal Items
 l Send Items to another Subcontractor

Working with Submittal Packages
Subcontractors with Create Submittal permission can create submittal packages in a similar manner as the 
general contractors with Add/Edit Submittal permission.

After the subcontractor creates submittal packages, the subcontractor can then use the Submit to GC action 
to start the review process. All submittals must route through the GC, and cannot be sent directly from the sub-
contractor to the submittal coordinator or design team.

To work with submittal packages, see the following pages:
 l Create Submittal Packages
 l Add Items to Submittal Packages
 l Remove Items from Submittal Package
 l Submit Packages to GC

Related Topics:
 l Submittal Package Page Overview

Submit Packages to GC

Subcontractors can optionally create submittal packages, and then submit to the GC.

To submit submittal packages to a GC
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 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the check box next to the packages you want to submit to the GC.
 3. Click Submit to GC.

The Submit to GC dialog box displays.

Note: For a description of the fields on this page, see Submit to GC.

 4. Enter all necessary fields.

Note: The General Contractor drop-down list will contain a list of individuals for selection to receive 
the submittal item. If no names appear in the list, then the GC or project administrator needs to 
identify the GC role that will manage submittals in the project submittal settings page.

 5. Click Submit to GC.

Submittal Coordinator Tasks
A Submittal Coordinator can take the following actions from the Submittal Register page:

 l Forward Items to Design Reviewers
 l Update Submittal Statuses

Tip: Usually, submittal coordinators being members of the Design team, cannot close out submittals. 
However, Admins can give Submittal Coordinators the Add/ Edit permission in addition to the Submittal 
Coordinator designation. With these additional permissions, they will be able to perform the following 
actions: 

 l Manage the design review team with the Forward for Review action
 l View all “hidden” comments & attachments, and determine which ones are shown to the construction 

team
 l Make final determination of submittal status and use the Return to Contractor action
 l Close the submittal. (Must return it to the contractor first as a separate action.)

A description of the fields and buttons located on the Submittal Register page is provided below:

Submittal Coordinator Action Buttons
 l Update Status: Click to update the status of select items. This option is primarily used to update 

multiple items with the same status. To update individual items, click the drop-down arrow in the 
Status column. For instructions, see Update Status for Multiple Items.

 l Forward for Review: Click to forward select items to sub-consultants for review. e-Builder licensed 
sub-consultants have the ability to forward items to other subs as well. When this occurs, the Held 
By field will be populated with the name or email addresses of all reviewers that have not yet taken 
action on the item.

Click the Reviewers link to see a list of all sub-consultants that have reviewed the item, the date the 
item was forwarded and if available, the date that the review was completed. 
The Held By column will list the Submittal Coordinator's name when there are no longer any reviews 
pending. For instructions, see Forward Items to Sub-Consultants for Review.

manage_submittal_permissions.htm
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Forward Items for Review
After items are received from the general contractor, the submittal coordinators will be able to forward those 
items to their sub-consultants for review. Multiple items can be forwarded at a time. e-Builder-licensed review-
ers have the ability to forward items to other subs as well. 

Note: There are two types of forwards. You can forward to simply notify the recipient of the item or require 
action from them. Notifying is simply an FYI because the item is not placed in their court. Requiring action 
places the item in the recipient's court.

To see a list of everyone who the item was sent to, click the "Reviewers" link on the Submittal Register page. 
The reviewers whose court the item is in (meaning those who have not yet responded to the review request) 
will be listed in the "Held By" column on the Submittal Register page. The item will not be back in your court 
until all reviews are complete. However, you will still be able to send items back to the GC, even if all reviewers 
do not provide a response.

To forward items for review

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Select the check box next to the item(s) you want to forward.
 3. Click Forward for Review.

The Forward for Review window appears.

 4. Complete all necessary fields.

Note: In the Send Type field, you can select whether to forward the item as a notification or require 
action from the recipient. The Action Required option will place the item in their court. Notify, is more 
like a CC or an FYI. This option is typically accompanied by a message.

 5. Click Forward for Review.

Related Topics:
 l Submittal Register Page Overview
 l Submittal Item Details Page Overview



e-Builder Submittals

Page xxxi

Add Comments to Submittal Items
Users with View rights can add comments to a submittal item. Once they send the item to another resource, 
they can no longer add comments.

Example: Submittal coordinators typically add comments and attachments while reviewing items between 
themselves and their reviewers. Once they send the item to the GC, they can no longer add comments.

Note: If the Hide Comments and Attachments feature is enabled on the account, comments and associated 
attachments will be hidden from the GC by default. To make individual comments visible, click the cor-
responding "Show" link. If a "Show" link does not appear, it's an indication that this feature is not set and all 
comments and attachments will be visible to the GC. 

To add comments to a submittal item

 1. Open the Submittal Item Details page.
 2. Click the Comments tab, and then Add Comments.

The Add Comments page is displayed.

 3. Enter comments.
 4. Optionally, you can attach documents to your comments by clicking Attach Documents.
 5. Click Save.

Related Topics:
 l Redline Submittal Documents
 l Stamp Submittal Documents
 l Reply to Submittal Items
 l Send Items to another Subcontractor

Update Status of Multiple Items
Submittal statuses can only be updated by the submittal coordinator. When updating the status for multiple 
items, only one status can be selected.

To update the status of multiple submittal items

 1. Go to the Submittal Register page.
For instructions on how to access the Submittal Register page, see Access Submittals.

 2. Select the check box next to the submittal items you want to update.

Note: Select only those items that will be updated with the same status.

 3. Click Update Status. The Update Status dialog box displays.
 4. Click the New Status drop-down arrow to select the status you want to update the items to.
 5. Enter a comment.
 6. If the option is available to you, select or clear the Private check box to make your comment either 

private or public.

submittal_settings_page.htm
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Note: The Private Comments feature can be enabled by account administrators. This feature allows 
only users in select role to view and add private comments. For more information, see Manage Priv-
ate Comments.

 7. Click Save.

Related Topics:
 l Submittal Package Details Overview

Update Status of Individual Item
After reviews are returned to the submittal coordinator, he/ she will update the status of each item accordingly. 
You can update multiple statuses at a time, or each item individually, as outlined below.

Note: You can continue your review (update status or send to contractor) even if a response is not 
received for your reviewers.

To update the status of an individual item

 1. Go to the Submittal Register page. For access instructions, see Access Submittals.
 2. Click the Status drop-down arrow next to the item you want to update.

The Update Status dialog box appears.

 3. Enter a comment in the Comment field.
 4. If the option is available to you, select or clear the Private check box to make your comment either 

private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature allows 
only users in select roles to view and add private comments. 

 5. If the option is available to you, click Show all in Review to make these comments visible to the GC, 
otherwise all comments will be hidden from review.

Note: 
 l If the Hide Comment and Attachments feature is enabled on your account, by default, all the 

comments made between yourself and reviewers will be hidden from the GC when items are 
sent for review. However, you can make all comments visible by clicking the Show all in 
Review button or make individual comments visible by clicking the "Show" link next to that 
comment. 

 l If a note is marked private, but shown in review, the GC will only be able to see it if they are in 
a role that allows them to view private comments. Administrators can learn more about these 
settings by going to Submittal Settings.

 6. Click Save.

Show/ Hide Comments from Review
This task is only applicable to submittal coordinators who are working in an account where the Hide Comment 
and Attachments setting is enabled. When this setting is enabled, comments and files attached to comments 
are hidden from the GC by default when sent for review. However, you have the option to show  these com-
ments and their associated attachments in bulk or individually.

manage_private_comments.htm
manage_private_comments.htm
submittal_settings_page.htm
submittal_settings_page.htm
submittal_settings_page.htm
submittal_settings_page.htm
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If the Changes Private comments to Public (visible) when shown in review setting is turned on and if the 
Submittal Coordinator enables the shown in review setting, private comments will be switched to public com-
ments.

To show/ hide comments

 1. Open the Submittal Item Details page.
 2. To show/ hide comments, click the Comments tab.
 3. To show all comments in review, click Show all in Review.

—Or—
To show/ hide comments individually, click the Show or Hide link next to each comment, respectively.

 4. Click Update Status.

Related Topics:
 l Submittal Item Details Page Overview

Send Items to Contractor 
Individual items can be sent back to the contractor as they are completed. If responses have not been received 
from reviewers, this will not restrict you from completing the review and sending the item back to the con-
tractor. If the item is completed, it will be in your court and the reviewer's court.

To send submittal packages to the contractor

 1. Go to the Submittal Packages page. For access instructions, see Access Submittals.
 2. Select the package that includes the item(s) you want to send.

The Submittal Package Details page is displayed.

 3. Select the check box next to the item(s) you want to send
 4. Click Send to Contractor. The Send to Contractor window is displayed with the following fields:

 o Project: Name of the project.
 o Title: Title of the package.
 o Send To*: The name of the person to whom the items are to be sent.
 o CC Roles: Select the roles to which you want to send the items as a CC message.
 o CC Users: Select the users to whom you want to send the items as a CC message.
 o CC External Users Via Email: You have the ability to request comments from external project 

participants who may not have e-Builder access. Enter their e-mail addresses (one per line) in 
this box.

 o Select folder for external user to attach files: If you  allow external users to attach files with 
their comment, select a folder that recipient's files will be loaded into.

 o Message: Enter a message to accompany the request for comments.
 o Private: If this option is available to you, select or clear the Private check box to make your com-

ment either private or public.
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Note: The Private Comments feature can be enabled by account administrators. This feature 
allows only users in select roles to view and add private comments. For more information, see 
Manage Private Comments.

 5. Click Send to Contractor.

Related Topics:
 l Submittal Package Page Overview
 l Submittal Package Details Overview

Reviewer Tasks
A reviewer can take the following actions from the Submittal Register page:

 l Forward Items to Other Sub-Consultants for Review
 l Complete Review of Submittal Items
 l Add Comments
 l Stamp Submittal Documents
 l Redline Submittal Documents

Note: Only e-Builder licensed reviewers are able to forward items for review.

Reviewer Action Buttons

A description of the fields and buttons located on this page is provided  below:
 l Forward for Review: Click to forward select items to another sub-consultant for review. Your name 

and the name of the recipient(s) will display in the Held By field until action is taken on the item. Your 
names will remain available from the Reviewers link with a time stamp of what the review was com-
pleted. For instructions, see Forward Items to Other Sub-Consultants for Review.

 l Review Complete: Click to complete your review of the item(s). Your name will be removed from 
the Held By column and the date the item was marked reviewed will be available from the Reviewers 
link. For instructions, see Complete Review of Submittal Items.

Forward Items to Other Reviewers
Only e-Builder-licensed reviewers are able to forward items to other reviewers. External reviewers (those that 
do not have an e-Builder license) are not able to do so. 

Note: There are two types of forwards. You can forward to simply notify the recipient of the item or require 
action from them. Notifying is simply an FYI because the item is not placed in their court. Requiring action 
places the item in the recipient's court.

When an item is forwarded, it is effectively in the recipients courts and their name(s) or email addresses 
(external reviewers) will appear in the "Held By" column on the Submittal Register page. When recipients reply 
or mark their review complete, their name will be removed from this column. Also, all replies are sent to the per-
son who forwarded the item, not necessarily to the submittal coordinator. For example, if a design consultant 
forwards the item to an external consultant for additional information, when the external party replies, the mes-
sage will be sent to the design consultant. 

manage_private_comments.htm
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Until reviewers reply or mark their review complete, they have ownership of the item. Furthermore, a list of all 
reviewers is displayed by clicking the "Reviewers" link on the Submittal Register page. The reviewers table 
also provides insight into who forwarded the review and the date requested.

To forward items to other reviewers

 1. Open the Submittal Item Details page.
 2. Click Forward for Review.

The Forward for Review window is displayed.

 3. Complete all necessary fields.

Note: In the Send Type field, you can select whether to forward the item as a notification or require 
action from the recipient. The Action Required option will place the item in their court. Notify, is more 
like a CC or an FYI. This option is typically accompanied by a message.

 4. To complete your review and also forward, click Forward and Complete Review.
—Or—
To forward for review without marking your review complete, click Forward for Review.

Note: You are able to complete your review at a later time.

Related Topic:
 l Submittal Item Details Page Overview

Mark Reviews Complete
Once you have completed your review of the item by adding comments, replying, and/ or attaching doc-
uments, you must mark your review complete. Doing so will remove your name from the "Held By" field on the 
Submittal Register page and the item will no longer be in your court. An email will be sent to the person who for-
warded the item to you - this might be the submittal coordinator or another reviewer.

To mark your review complete

 1. Open the Submittal Item Details page.
 2. Click Review Complete. The Review Complete Submittal Items window appears.
 3. Enter your comments.
 4. If this option is available to you, select or clear the Private check box to make your comment either 

private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature allows 
only users in select roles to view and add private comments. For more information, see Manage Priv-
ate Comments..

 5. Click Review Complete.

Related Topic:
 l About the Submittal Module
 l Submittal Register Page Overview

manage_private_comments.htm
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 l Submittal Item Details Page Overview
 l Reply to Submittal Items

Add Comments
The Add Comment page allows users of the Submittal module to add comments to individual submittal items. 
As a subcontractors, you can add comments as long as it is in your court. Once the item is sent off to another 
resource, you will no longer be able to add comments. 

The following topics will assist you in adding comments:
 l Add Comments to Submittal Items 
 l Show/ Hide Comments from Review (Submittal Coordinators)

Fields and Buttons

The fields and buttons on this page are:
 l Save: Click to save changes.
 l Check Spelling: Click to check the spelling of text fields.
 l Cancel: Click to discard changes. All unsaved changes will be lost.
 l Submittal Item: Displays name of the submittal item.
 l Comment: Enter your comment in this field.
 l Private: Displays only if you are in a role that has the permissions to add private comments. Select 

to make your comment private. Only users in roles that are able to see private comments will be able 
to view this message. If the submittal coordinator decides to include a Private comment in the final 
package to construction (Shown in Review), then the comment's visibility may automatically be 
changed to Public. For more information on this setting, see Manage Private Comments.

 l Attach Documents: Click to attach a document to your comment.
 l File Name: This column displays the name of the attached file.
 l Attached By: This column displays the name of the person that attached the file.

Comments - Columns
 l Private: A check mark in this column indicates that the comment is private which means that only 

users in roles that have permission to view private comments will be able to view this comment.
 l In Review: This column is displayed only if the Hide Comments and Attachments feature is enabled. 

A check mark in this column indicates that the comment will be visible to the GC in review. For 
instructions on showing or hiding comments from review, see Show/Hide Comments from Review.

 l Comment: This column displays the existing comment. From here you can make comments private 
or public and show or hide the comment from review, if these settings are enabled on the account. 
Click the title of the file to open or download it.

Stamp Submittal Documents
Document stamps are often needed to physically mark permits, drawings, submittals and payment applic-
ations. Electronically stamping PDF documents help you bypass printing, mailing and faxing files with your 
seal of approval. Each time a stamp is added, save the document as a new version or as a new document 

manage_private_comments.htm
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altogether.

Stamps are added to the system by account administrators. If you wish to have a specific file loaded into e-
Builder, see your account administrator and refer them to About Document Stamps for more information.

Note: Only PDF documents can be stamped.

To stamp submittal documents

 1. Open the Submittal Item Details page.
 2. Click the Documents tab, and then the Stamp link located underneath the file you want to stamp.

Note: The Stamp page appears with a list of available stamps in the left navigation pane.

 3. Drag and drop a stamp to the appropriate location on the file.
 4. To save the file as a new version, click Save as New Version. This will append a version number to the 

file name.
—Or—
To save the file with a new name, click Save as New Document. The File Name dialog displays for 
you to modify the document's name. Click Save.

Related Topics:
 l Redline Submittal Documents
 l Add Comments to Submittal Documents
 l Reply to Submittal Items
 l Send Items to another Subcontractor

Redline Submittal Documents
Adding redline markups allow you to annotate the file. Redlining does not modify the actual file; it creates an 
overlay on top of it that exists only in e-Builder. After you save your redline, a counter will appear under the file 
name that shows how many redline layers have been created for the document.

Tip
To view a redline markup outside of e-Builder, save the markup as a TIFF or PDF.

To redline submittal documents

 1. Open the Submittal Item Details page.
 2. Click on the Documents tab.
 3. Click the Redline link located below the name of the file you wish to redline.

The file opens up in a separate redlining window.

 4. Click the Markup icon  located in the upper left corner of the window.

 5. Click New Markup.
 6. From the Annotations drop down, select the type of markup you wish to make.
 7. Once the document has been marked up, do any of the following:

about_document_stamps.htm
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 o To save the file, click the Markup icon > Save Markup. Enter a unique name and then click OK.
 o To save the file as a PDF, click the More icon  > Publish to PDF.
 o To save the file as a TIFF, click the More icon  > Publish to TIFF.
 o To print the file, click the More icon  > Print.

Tip: You may need to maximize the redlining window to see the More icon.

Note: Click the Help icon located on the upper right corner of the window. A new window displays the 
in-app help that describes all the options available on the redline window. Depending on your 
browser settings, your redline window may be ‘hidden’ behind the help window. 

Related Topics:
 l Stamp Submittal Documents
 l Add Comments to Submittal Documents
 l Reply to Submittal Items
 l Send Items to another Subcontractor

Submittal Settings - Users
All users with View permissions to the Submittals module will be able to view the project-level submittal set-
tings. However, only the users with Manage Project Settings permissions will be able to edit and save project-
level submittal settings. The Submittal Settings page controls both optional and required settings, all of which 
will set the framework for the submittal process for a specific project. At a high level, here are some of the 
factors that you will determine from this page:

 l Assign a submittal coordinator (required)
 l Assign a fixed number of days for reviews to be returned
 l Choose your calendar offset type (calendar days or working days)
 l Determine operational factors for submittal packages
 l Determine operational factors for subcontractor-initiated submittals

A description of the fields and buttons located on this page is provided below:

Submittal Settings
 l Complete Review Due Date Offset: Enter the maximum number of days allowed for the submittal 

coordinator to complete the design review of submittal items or submittal packages and return them 
to the general contractor. The review due date offset is an optional field provided to help contractors 
meet time-sensitive obligations.             

Example
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If a contractual obligation exists for submittal items to be returned within a predetermined time 
frame, those number of days may be entered in this field to facilitate this initiative.

Tip
Create a weekly reports subscription for submittal items. On a weekly basis you will receive a 
report via email on the status of each submittal item or package. Note that you can group sub-
mittal reports by the Held By field and split the names listed to separate rows by clicking the 
Return row for each multivalued field value check box on the Select Columns step of the 
report wizard.

Best Practice
Review these reports regularly to stay abreast of the status of each submittal item and make 
inquiries as necessary. Having this insight allows you to take a proactive approach, intercept 
delays, and ensure the submittal process is aligned with the construction schedule and that con-
tractual obligations are being met.

 l Offset Type: Select whether the Complete Review Due Date Offset will be calculated on calendar 
days or working days. 

 l Specify Default Folder for Attachments:  Optionally, you can specify a folder in which all attach-
ments will be stored. This setting will apply to all submittal process participants. 

 l Submittal Coordinator (Required):  Click the Select From drop-down list to narrow available names 
to a single role. In many organizations, the Submittal Coordinator will be the Architect/ Engineer on 
the project or a project manager within the owner's organization. Although you can identify multiple 
submittal coordinators for the project, only one submittal coordinator can be assigned to an indi-
vidual item. A submittal coordinator assigned with items in review cannot be removed from the pro-
ject's submittal coordinator list. The Submittal Coordinator list must have at least one name 
assigned.  If multiple submittal coordinators exist, they cannot be removed from the list unless they 
are under “No items in review” heading.

Best Practice
Submittal coordinators can act on each others items, so it is a good idea to designate at least two 
coordinators per project in case a backup is needed.

 l Who to Notify:  Select the roles or users that should be notified when any action is taken on a sub-
mittal item.

Best Practice

Be judicious in assigning this setting because it can generate an extremely large volume of email 
notifications for recipients.

 l Notify Submittal Coordinator on Review Complete:  This setting is used on projects where each 
design reviewer uses the Forward and Complete Review action to forward to the next design 
reviewer (sequential or "daisy chain" reviews). When this box is checked, a notification is sent to the 
submittal coordinator after the final reviewer clicks Complete Review action. With the box 
unchecked, the submittal coordinator only receives notifications for the first level of reviews sent via 
Forward for Review actions. This is usually sufficient for projects using parallel design reviews.

Submittal Package Options
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The options in this section affect submittal package options at the project level. Each of these settings are 
also available at the account level. Administrators, see Submittal Package for more information. Settings at 
the project level will supersede account settings.

 l Use CSI List: Click the drop-down list to choose whether or not submittal packages should use CSI 
codes. This is an account level setting that applies to all projects in the account. Whether this feature 
is set to yes, or no, users can still enter free-form text into this field.             

Yes is the default value. When CSI codes are used, they represent the second set of numbers in the 
submittal package number.

No will effectively remove the second Submittal Package setting option: CSI List to Use. While cre-
ating a submittal package, the CSI Codes drop-down list will not display on the Submittal Package 
page if this feature is set to No. However, a space will be provided for users to enter a second set of 
numbers in the Submittal Package # field. Free-form text entry is allowed, or the field may be left 
blank for a two digit set submittal package number.

 l CSI List to Use: This option only displays if Yes is selected in the Use CSI List option. Click the 
drop-down arrow to select a CSI format. Available options include:             

 o CSI MasterFormat 1995
 o CSI MasterFormat 2004
 o CSI MasterFormat 2012
 o User Defined List

Best Practice
If User Defined List is selected, the package numbering will use the Construction Codes from the 
Account Setup module, which can be loaded with an imported custom list of CSI codes.

 l Submittal Item Spec Section Populated by CSI Code: This option is displayed only if Yes is 
selected in the Use CSI List option.
If selected, the Spec Section field on the Add/ Edit Submittal Item page will be a drop-down menu of 
CSI options as opposed to a free-form entry field. This setting would help reduce errors that could be 
introduced with free-text entry.

Tip
If you track items by spec section, make this a required field to ensure this information is always 
captured. For instructions, see Manage Required Fields.

 l Auto Numbering Packages: 
Per Code: Choose this option to automatically number submittal package records in sequential 
order (1, 2, 3, etc.), by division.                  

Example
All submittal packages in division one are numbered in sequential order. All submittal packages 
in division two are numbered in sequential order, and so forth.

Per Project: Choose this option to automatically number submittal package records in sequential 
order (1, 2, 3, etc.), regardless of division.

submittal_packages.htm
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Example
Submittal packages are numbered sequentially in the order in which they are created, regardless 
of division.

 l Honor Auto-Close Status: Select this check box, if the submittal items are to be  automatically 
placed in the 'Closed' status when the item is set to a specific status predefined by the account 
administrator.  This account setting can be overridden at the project level by users with Add/Edit per-
mission or an administrator. 

 l Allow Items to be Added After Review Starts: Selecting this box enables the Add Items button 
on the Submittal Packages Item tab. This applies to open packages after being sent for review to the 
submittal coordinator. When this is turned on, team members with the following permissions can add 
items: 

 o Create permission for the packages they authored 
 o Add/ Edit permission 
 o Administrators

 l Allow Revision Items to be Added to Existing Packages: Selecting this box adds a drop-down 
list for Submittal Package when creating a submittal revision. From the drop-down, you can either 
create a new package in the same series (same package number and incremented revision), OR 
you can select an existing open package in the series to attach the revised item to. The revised sub-
mittal item cannot be added back into the same package that it currently exists in. For projects with 
large numbers of resubmittals, this helps consolidate the number of packages in review. 
This setting is independent from the "Allow Items to be Added After Review Starts" setting above. 
Revisions can be added to any open package within the package number series, even if it has been 
forwarded for review. For projects with large numbers of resubmittals, this helps consolidate the 
number of packages in review.

Subcontractor Options

This section is not visible until at least one role has been assigned the Create Submittal permission (typ-
ically used for subcontractors).

Submittal options are used on projects where subcontractors will create some or all of the submittal register 
items, and use the Submit to GC action to kick off the review process. If the subcontractors are not licensed 
e-Builder users or are not actively participating in the review process, disregard these settings.

 l General Contractors for Submission: Select the role that contains the GC personnel who will 
receive the submittals from the subcontractor. The subcontractor will select an individual recipient 
from the list of users in the identified role.                  

Only roles that have the Add/ Edit Submittals permission are listed in this drop-down list. If no roles 
are visible, check with the Account Administrator to verify the role permissions.

 l GC Review Complete Due Date Offset: Enter the number of planned days for the GC to complete 
an initial review and forward to the submittal coordinator. The offset will calculate a suggested due 
date in the Submit to GC step, which the subcontractor can modify if necessary.                         
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The GC Review time frame is separate from the Complete Review time frame (for submittal coordin-
ator and design team).

 l Offset Type: Select whether the GC Review Complete Due Date Offset will be calculated on cal-
endar days or working days.    

Add/Edit Submittal Items
This page allows the general contractor (Add/Edit Submittal permission) or subcontractor (Create Submittal 
permission) to add individual submittal items to the submittal register.

Adding submittal items is typically done in bulk via import before the submittal process gets underway. Indi-
vidual items can easily be added when necessary.

To access the Add Submittal Item Details page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 
 3. Click the title of a submittal item to view its details. The Submittal Item Details page is displayed for 

the selected item.
 4. Click Add Item to view the Add Submittal Item page.

To access the Edit Submittal Item Details page
 1. On the Home page, click the All Projects drop-down menu to select a project.
 2. In the Project Menu on the left navigation pane, click the Submittals link. 
 3. Click the title of a submittal item to view its details. The Submittal Item Details page is displayed for 

the selected item.
 4. Click Edit to view the Edit Submittal Items page.

A description of the buttons located on the Add/ Edit Submittal Item page is provided below:

Toolbar Buttons
 l Save & Add New: Click to save changes and add an additional submittal item.
 l Save: Click to save changes.
 l Cancel: Click to discard changes and return to the Submittal Register page.

Details Section

This section allows you to enter descriptive information about the submittal.
 l Project: Displays the project name.
 l Title: Enter the title of the submittal item.
 l Description: Enter an additional description of the item.
 l Number: Submittal Item numbers are generated by e-Builder starting with 1. A number will be 

assigned to this item after saving.
 l Submittal Package: The GC will typically package submittal items after they've been submitted by 

a subcontractor, however, the system allows you to add draft items to a package at any time. When 
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adding a submittal item, this field is editable and allows you to choose an existing Submittal Pack-
age to add the item to. For instructions on creating a new package, see Create Submittal Packages. 
When editing a submittal item, this field is editable for draft items only (Items that have not been sent 
to the Submittal Coordinator for review) and allows you to choose a new submittal package. Once 
the package has been sent for review, this will be a non-editable field.

Note: Submittal package numbers are auto-generated according to project or CSI code, depend-
ing on the account setting.

 l Spec Section: Enter the specification section in this field. In many cases this will be the CSI code 
used on the submittal item.

 l Category: Click this drop-down arrow to select the category that the submittal item belongs to. Sub-
mittal categories are customizable by account administrators, therefore available categories may 
vary.

Default categories provided by e-Builder include:
 o As-Builts
 o Bid Submittals
 o Certification
 o Commissioning Scripts
 o Mock Up
 o Operation/Maintenance Manual
 o Product Data
 o Sample
 o Shop Drawing
 o Test Report

 l Responsible Sub/Manufacturer: Enter the name of the subcontractor or manufacturer responsible 
for completing the work for this submittal item.

 l Project Number: If available, the project number displays in this field. Project numbers allow you to 
have a unique identifier for each of your projects. Account administrators can add project numbers 
by going to Administration Tools > Projects > Project Settings > Choose a custom field option from 
the Project Number Custom Field drop-down menu.

 l Status: By default, all new submittal items enter the system in New status. This status will be 
updated by the submittal coordinator after they review the item.

 l Item Status: Submittal items are in a draft state when they're entered into the system. Submittal 
item statuses typically follow this life cycle:

 l Draft: Items that have not yet been added to a submittal package.
 l Open: Items that have been added to a submittal package.
 l Closed: Items whose status has been updated to Close by the general contractor after review has 

been completed by the submittal coordinator, UNLESS the project and account setting is enabled 
that automatically sets the submittal item statuses to Closed when a specific status is selected by 
the submittal coordinator. For more information, see one of the following:

submittal_packages.htm#autonumberpackages
submittal_packages.htm


e-Builder Submittals

Page xliv

 o Account setting: Manage Submittal Register Options
 o Project setting: Submittal Settings Page 

 l Submittal Coordinator: The submittal coordinator to whom the item is assigned. Project submittal 
coordinators and administrators can change the Submittal Coordinator on submittal items in review 
to another coordinator assigned on the project. Submittal coordinator changes will be logged and dis-
played on the History tab on the Submittal Item Details page. When the submittal coordinator is 
changed, an email notification will be sent to the new submittal coordinator about the submittal item 
assignment. 

Note: This field is displayed only if the submittal coordinator reassignment feature has been 
enabled for the project and all users who are in the submittal coordinator list for the project will be 
available for selection.

 l Priority: All items are set to Normal priority by default. Click this drop-down arrow to give this item a 
different priority level, such as Low or High. If changed, one of the following priority icons will appear 
next to the item on the Submittal Register page:

 High Priority

 Low Priority

 l Revision: A revision number is automatically assigned when a revision is made to the item.
 l Sub Section: Enter the sub section in this field. In many cases this will be the sub section CSI code 

used on the submittal item.
 l Commitment: Click this drop-down arrow to select a commitment to tie this item to.

Date Details

This section allows you to enter the date details for the submittal item. Target dates are entered in the left 
column and the actual dates in the right column.

Note: Date details can also be imported. See Import Submittal Register for instructions.
 l Date Due From Subcontractor: Date the submittal item content needs to be submitted to the gen-

eral contractor from the subcontractor. Also set by the GC with the Send to Sub action.
 l Submit For Review Due Date: Date the general contractor needs to send the item to the submittal 

coordinator to start the design review.
 l Review Complete Due Date: Date that the design review needs to be completed, and the submittal 

coordinator returns the item to the general contractor. Also set by the GC with the Send for Review 
action.

 l Consultant Respond By Date: Date that all of the design reviewers need to be completed, and 
returned back to the submittal coordinator. Also set by the submittal coordinator with the Forward 
for Review action. This field may or may not be editable when entering a submittal item, depending 
on the account setting. See Allow Editing of System-Generated Dates for more information.

 l Return Due Date: Date the general contractor needs to return the item to the responsible sub-
/manufacturer after finalization by the submittal coordinator.

submittal_register_options.htm
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 l Delivery Due Date: Date the item needs to be delivered to the facility or final destination, after it has 
been approved.

 l GC Complete Review Due Date: Date the GC needs to forward to the submittal coordinator after 
receiving from the subcontractor. Also set by the subcontractor with the Send to GC action.

 l Date Received From Subcontractor: Actual date that the item was received from the sub-
contractor. Automatically updated when the subcontractor uses the Reply action.

 l Date Submitted For Review: Actual date the item was sent to the submittal coordinator. Auto-
matically updated when the GC uses the Send for Review button. This field may or may not be edit-
able when entering a submittal item, depending on the account setting; see Allow Editing of System-
Generated Dates for more information.

 l Date Review Completed: Actual date the submittal coordinator completes the review of this item 
and sends it back to the contractor. Automatically updated when the submittal coordinator uses the 
Send to Contractor action. This field may or may not be editable when entering a submittal item, 
depending on the account setting. See Allow Editing of System-Generated Dates for more inform-
ation.

 l Consultant Review Complete Date: Actual date when the final design reviewer completes review 
and returns to the submittal coordinator. Automatically updated when the final reviewer uses the 
Review Complete action. This field is not editable when entering a submittal item. This date will 
automatically update when the final reviewer returns the item to the submittal coordinator.

 l Date Returned: Enter the actual date that the item was sent to the responsible party, after the sub-
mittal coordinator's finalization.

 l Date Delivered: Enter the actual date that the item was delivered to its destination.
 l Date Sent to Subcontractor: Actual date the GC requests documentation from the subcontractor. 

Automatically updated when the GC uses the Send to Sub action.
 l Date Sent to GC: Actual date the subcontractor sends item to the GC. Automatically updated when 

the subcontractor uses the Submit to GC action.

Custom Fields 

If available, submittal custom fields are displayed in this section for you to complete.

Submittal Item Details
This page allows you to view the details of a submittal item. The different participants of the submittal process 
will be able to take certain actions from this page, depending on the state of the item. Below is a list of tasks 
that each participant can complete from this page if the item is in their court. 

Tasks  in the Submittal process

General Contractor Tasks:

 l Send Item to Subcontractor
 l Delete Submittal Item
 l Edit Submittal Details

Submittal Coordinator Tasks:

 l Forward Items for Review
 l Update Status of Individual Item
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Tasks  in the Submittal process

Subcontractor Tasks:

 l Edit Submittal Details
 l Delete Submittal Item
 l Submit Item to GC
 l Send Items to Another Sub-

contractor
 l Reply to Submittal Items

Reviewer Tasks:

 l Forward Items to other Review-
ers

 l Complete Review of Submittal 
Items

A description of the fields, buttons and tabs located on this page are provided  below:

Action Buttons 

General Contractor with Add/ Edit Submittal Permission
 l Send to Sub: Click to send the item to a subcontractor. For instructions, see Send Item to Sub-

contractor. 
This button displays only for draft submittal items that have not yet been sent to the submittal 
coordinator for review. 

 l Delete: Click to delete the item. For instructions, see Delete Submittal Items. 
This button is displayed only for draft submittal items (items that have not yet been sent to the sub-
mittal coordinator for review or items that have not yet been added to a submittal package).

 l Edit: Click to edit the details of the item. For instructions, see Edit Submittal Details. 
This button is displayed only for draft submittal items that have not yet been sent to the submittal 
coordinator for review.

 l Close: Click to close the item. 
This button is displayed for Open items that have been returned by the Submittal Coordinator after 
the design review is completed.

Subcontractor with Create Submittal Permission
 l Submit to GC: Click to send the item to a general contractor. Items do not need to be inside a pack-

age at this point. For instructions, see Submit Items to GC.
This button is displayed only for draft submittal items that were created by the subcontractor with 
Create permissions.

 l Delete: Click to delete the item. For instructions, see Delete Submittal Items.
This button is displayed only for draft submittal items that were created by the subcontractor with 
Create permissions.

 l Edit: Click to edit the details of the item. For instructions, see Edit Submittal Details.
This button is displayed only for draft submittal items that were created by the subcontractor with 
Create permissions.

 l Send to Sub: Click to send the item to a subcontractor. For instructions, see Send Items to Sub-
contractor. 
This button is displayed only to licensed subcontractors who receive a submittal item from the GC 



e-Builder Submittals

Page xlvii

using Send to Sub action. The receiving subcontractor can in turn send the item to a different sub-
contractor.

 l Reply: Replying will remove your name from the Held By column and the item will no longer be in 
your court. For instructions, see Reply to Submittal Items.
This button is displayed only to subcontractors who receive a submittal item from the GC using Send 
to Sub action. The receiving subcontractor can reply to the person that sent the submittal item; this 
may be the general contractor or another subcontractor.

Submittal Coordinator
 l Forward for Review: Click to forward the item to the design team for review. For instructions, see 

Forward Items for Review.
 l Update Status: Click to update the status of the submittal item. For instructions, see Update Status 

of Individual Item.

Reviewer 
 l Forward for Review: Click to forward the item for review. Doing so will add the recipient's name in 

the Held By field on the Submittal Register page. When this person responds, it will be sent back to 
you. For instructions, see Forward Items to other Reviewers. 
Only e-Builder licensed reviewers are able to forward items on to other reviewers. External review-
ers (those that do not have an e-Builder license) are not able to forward items for review.

 l Review Complete: Click to mark your review complete. This will place the item back in the court of 
the person that forwarded it to you. For instructions, see Mark Review Complete.

Tabs

Submittal Item Overview Tab

For a list of fields in this section and their descriptions, see Add/Edit Submittal Item Page Overview.

The following tabs are available at the bottom of the page:
 l Documents Tab: The Documents tab lists all files that are attached to the item. If the item is in your 

court, you can also add documents of your own.

Note: If the Hide Comments and Attachments feature is enabled on your account, submittal 
coordinators will see options to show or hide attachments in review. With this account setting, com-
ments and attachments added by reviewers and the submittal coordinators are hidden by default 
and the submittal coordinator will have to choose which ones to make visible to the general con-
tractor. Note that the submittal also needs to be in the submittal coordinator's court in order to 
make these edits.

 l Comments Tab: The Comments tab lists all comments made about the item. If the item is in your 
court, you can also add comments of your own.

submittal_settings_page.htm
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Note: 
 o If the Hide Comments and Attachments feature is enabled on your account, submittal 

coordinators will see options to show or hide comments in review for items in their court.
 o With this account setting, comments and attachments added by reviewers and the sub-

mittal coordinators are hidden by default. The submittal coordinator will choose which 
items to make visible to the general contractor as part of the final review. 

 l Custom Fields Tab: The Custom Fields tab lists the custom fields associated with the item.
 l Revisions Tab: The Revisions tab lists all the details of all revisions to the item.

Date Details Tab
 l Date Descriptions: Refer to the Add/Edit Submittal Item Page Overview.

History Tab
 l Created By: Displays the name of the person who added the item the system.
 l Last Modified By: Displays the name of the person who last modified the item.
 l Last Action: Displays the name of the person who last took action on the item.
 l Created Date: Displays the date that the item was created.
 l Last Modified Date: Displays the date that the item was last modified.
 l Last Action Date: Displays the date that action was last taken on the item.
 l Action: Displays the action that was taken on the item.
 l User: Displays the name of the user that took the action.
 l Date: Displays  the date that the action was taken on the item.
 l Description: Displays the description of the action in more detail.
 l Previous: Displays  the status of the item before the action was taken.
 l New: Displays  the status of the item after the action was taken

Submittal Package
The Submittal Package page lists all available submittal packages and high-level details for each package.

Submittal Packages are used to group related Submittal Items that move through the review process together 
and serves as a convenient mechanism to apply actions in bulk to all of the Submittal Items within the pack-
age. However, sometimes during the review process, it becomes apparent that certain items within a package 
require different reviewers or longer review periods. E-Builder provides the flexibility to handle each submittal 
item separately if necessary.

Note: When the View draft submittals account-level setting is enabled, all team members who have the 
View Submittals permission will be able to see Submittal Packages that are in Draft status.

The columns included in the table of Submittal Packages on this page may vary if the account administrator 
has established custom submittal package layouts through the Setup Module.

The following actions can be taken from this page:

General Contractor Tasks:

submittal_settings_page.htm
submittal_settings_page.htm
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 l Create Submittal Packages
 l Send Submittal Packages for Review

Subcontractor Tasks:
 l Create Submittal Packages
 l Submit Submittal Packages to GC

Submittal Package page - Fields and Buttons 

Tip: The Submittal Package filter allows you to narrow down the results list to just the packages you need 
to view. This filter can be collapsed to increase screen real estate, and then expanded if necessary, by 
clicking the expand/collapse button in the upper-left corner of the page.

A description of the fields and buttons located on the Submittal Package page is below:
 l Title: Enter the title of a package to filter by.
 l Description: Enter text included in the description of a specific item(s) to filter by.
 l Trade: Enter a trade in this field to filter by packages of a specific trade.
 l Submittal Package #: Enter a submittal package number to filter by items located in a specific 

page. You can filter on any part of the package number.
 l Priority: Click to filter for packages the include items of a specific priority level.
 l Custom Field 1: If applicable, click this drop-down arrow or enter a submittal package custom field 

to filter by packages that are associated with a particular custom field.
 l Open: Select to filter for open packages, which are those that have not yet been sent for review.
 l Closed: Select to filter for closed packages.
 l Draft: Select to filter for draft packages.
 l Overdue: Select to filter for overdue packages.
 l Custom Field 2: If applicable, click this drop-down arrow or enter a submittal package custom field 

to filter by packages that are associated with a particular custom field.
 l Clear: Click to clear the filter.
 l Filter: Click to filter by the specified criteria.
 l Create Package: Click to create a new submittal package.
 l Send for Review: Click to send select packages to the submittal coordinator for review.
 l Title: Displays the title of the package.
 l Description: Displays the description of the package.
 l Package #: Displays the package number.
 l Revision Number: Displays the revision number.
 l Status: Displays the status of the package.
 l Held By: Displays the name or email address of the people who currently have ownership of an item 

located in the package.
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Submittal Packages Details
The Submittal Package Details page allows all participants of the submittal process to view the details of a 
package and take the appropriate actions. The action buttons are permissions based, and therefore may not 
be available to all team members.

The top portion of this page provides high level information about the package. The Items tab below this lists 
all the items in the package.

The following actions can be taken from this page:

Actions that can be taken from the Submittal Package Details page 

General Contractor Tasks:

 l Request Comment 
 l Generate Transmittals
 l Update Dates
 l Edit Package
 l Close Package
 l Reopen Package
 l Send Individual Items for Review
 l Send Item to Subcontractor
 l Create Revision
 l Add/ Remove Items from Submittal Pack-

age

Submittal Coordinator Tasks:

 l Request Comment 
 l Generate Transmittals
 l Update Status of Multiple Submittal 

Items
 l Update Status of Individual Item
 l Edit Package
 l Forward Items for Review
 l Send Items to Contractor

Subcontractor Tasks:

 l Request Comment 
 l Add Items to Submittal Packages
 l Remove Items from Submittal Package
 l Edit Package 
 l Submit Item to GC
 l Send Item to another Subcontractor
 l Reply to Submittal Item
 l Close Submittals
 l Reopen Submittals
 l Create Revision Submittals

Reviewer Tasks:

 l Request Comment
 l Forward Items to Other Reviewers
 l Mark Reviews Complete

The following sections on this page are available  below:

General Contractor Action Buttons - Add/ Edit Permissions
 l Request Comment: Click to request a comment on the submittal package. This feature may be 

used if additional information is needed.
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 l Update Dates: Click to update the dates of the items located in the submittal package.
 l Generate Transmittal: Click to generate a transmittal. A transmittal is a word document that sum-

marizes the details of a submittal package. The name of the package, and a list of all submittal items 
the package is comprised of are listed in a transmittal. Details for each submittal item are also 
included such as item numbers, categories, statuses, and notes. A transmittal can be used in a num-
ber of ways. They are often used as a cover sheet when sending hard copy materials to the sub-
mittal coordinator. Optionally, a transmittal can also be attached to a submittal package before it is 
sent to the submittal coordinator to maintain a paper trail of physical materials.

 l Close: Click to close the submittal package.
 l Edit: Click to make changes to the details of the package, such as the package name, description, 

package number and trade.
 l Send for Review (Item Level): Click to send selected items to the submittal coordinator for review. 

The submittal item status will change from "NEW" to "In Review". 

Note: You can send individual items for review even if they are in the court of a subcontractor. 
Doing so will update the "Held By" field with the submittal coordinator's name.

 l Send to Sub (Item Level): Click to send selected items to a subcontractor to request that they 
attach documentation for review.

 l Add Items (Item Level): Click to add existing or new submittal items from the submittal register into 
the package. This action only applies to Draft packages, or if the Project Submittal Setting "Allow 
items to be added after review starts" option is turned on.

 l Create Revision (Item Level): Click to create a revision to the submittal package that contains the 
selected items. This action only applies to items that have been returned from the Submittal Coordin-
ator. This action creates a new package in Draft status with the next sequential revision number. 
You will have the option to rename the new revision package. Selected items are also incremented 
to the next revision numbers and added to the revised package.

 l Remove Items (Item Level): Click to remove items from the submittal package. In the event that 
items were added to a package incorrectly, general contractors are able to remove these items as 
long as the package is not in Close or Approve status. To remove individual item(s), they cannot be 
approved or currently in review.

Subcontractor Action Buttons - Create Permissions
 l Request Comment: Click to request a comment on the submittal package. This feature may be 

used in case additional information is needed.
 l Edit: Click to make changes to the details of the package, such as the package name, description, 

package number and trade. This action is only available for Draft packages that the subcontractor 
created.

 l Send to GC (Item Level): Click to send selected items to a general contractor to start the review pro-
cess.

 l Add Items (Item Level): Click to add existing or new submittal items from the submittal register into 
the package. This action only applies to Draft packages that the subcontractor created, or if the Pro-
ject Submittal Setting Allow items to be added after review starts option is turned on.
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 l Remove Items (Item Level): Click to remove items from the submittal package. In the event that 
items were added to a package incorrectly, subcontractors are able to remove these items from 
packages that they created, as long as the package is not in Close or Approve status. The individual 
item(s) cannot be approved or currently in review.

 l Close: Click to close the submittal package.
 l Create Revision (Item Level): Click to create a revision to the submittal package that contains the 

selected items. This action only applies to items that have been returned from the Submittal Coordin-
ator. This action creates a new package in Draft status with the next sequential revision number. 
You will have the option to rename the new revision package. Selected items are also incremented 
to the next revision numbers and added to the revised package.

Subcontractor Action Buttons - View Permissions
 l Send to Sub (Item Level): Click to send selected items to another subcontractor. This action is avail-

able on items that the GC sent using the Send To Sub action. You may need to send items to 
another sub for a second opinion or to solicit additional information. When the recipient replies, the 
message will be sent directly to you. A log of this action will be captured on the submittal item history 
tab. Additionally, the recipient's name or email address (for external subcontractors) will be added to 
the "Held By" column on the Submittal Register page, indicating that the item is currently in their 
court as well. When they reply, their name will be removed from this column, but will remain on the 
list of reviewers.

Note: Only licensed e-Builder subcontractors are able to send items to another subcontractor.

 l Reply (Item Level): Replying to the submittal item will send a message to the person that sent you 
the submittal item. This action is available on items that the GC sent using the Send To Sub action. 
The item may have been sent to you by the general contractor or another subcontractor. After reply-
ing, your name will be removed from the "Held By" column and the item will no longer be in your 
court.

Submittal Coordinator Action Buttons
 l Request Comment: Click to request a comment on the submittal package. This feature may be 

used in case additional information is needed.
 l Generate Transmittal: Click to generate a transmittal. A transmittal is a word document that sum-

marizes the details of a submittal package. The name of the package, and a list of all submittal items 
the package is comprised of are listed in a transmittal. Details for each submittal item are also 
included, such as item numbers, categories, statuses, and notes. A transmittal can be used in a num-
ber of ways. They are often used as a cover sheet when sending hard copy materials to the general 
contractor. Optionally, a transmittal can also be attached to a submittal package before it is sent to 
the general contractor to maintain a paper trail of physical materials.

 l Update Status (Item Level): Click to update the status of selected items.
 l Send to Contractor (Item Level): Click to send selected items to the contractor. Individual items 

can be sent back to the contractor as they are completed. Furthermore, if responses have not been 
received from reviewers, it will not restrict you from completing the review and sending the item back 
to the contractor.
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 l Forward for Review (Item Level): Click to forward selected items for review. Multiple items can be 
forwarded at a time. e-Builder-licensed reviewers have the ability to forward items to other reviewers 
as well. To see a list of everyone who the item was sent to, click the "Reviewers" link on the Sub-
mittal Register page. The reviewers whose court the item is in (meaning those who have not yet 
responded to the review request) will be listed in the "Held By" column on the Submittal Register 
page. The item will not be back in your court until all reviews are complete. However, you will still be 
able to send items back to the GC, even if all reviewers do not provide a response.

Reviewer Action Buttons
 l Request Comment: Click to request a comment on the submittal package. This feature may be 

used when additional information is needed.
 l Forward for Review (Item Level): Click to forward selected items for review. This action is available 

for items where the reviewer is included in the Held By list. External reviewers (those that do not 
have an e-Builder license) are not able to forward items to other reviewers. When an item is for-
warded, it is listed in the recipients' courts and their name(s) or email addresses (external reviewers) 
will appear in the "Held By" column on the Submittal Register page. When recipients reply or mark 
their review complete, their name will be removed from this column. All replies are sent to the person 
who forwarded the item, not necessarily to the submittal coordinator. For example, if a design con-
sultant forwards the item to an external consultant for additional information, when the external party 
replies, the message will be sent to the design consultant. Until reviewers reply or mark their review 
complete, they have ownership of the item. A list of all reviewers will be available by clicking the 
"Reviewers" link on the Submittal Register page. The reviewers table also provides insight into who 
forwarded the review and the date requested.

Note: Only e-Builder-licensed reviewers are able to forward items to other reviewers.

 l Review Complete (Item Level): Click to mark your review of selected items as complete. This 
action is available for items where the reviewer is included in the Held By list. Doing so will remove 
your name from the "Held By" field on the Submittal Register page and the item will no longer be in 
your court. An email will be sent to the person who forwarded the item to you - this might be the sub-
mittal coordinator or another reviewer.

Submittal Package Overview Tab

See Submittal Package Page Overview for the field descriptions for this tab.
 l Submittal Coordinator: Displays the name of the submittal coordinator the pack was sent to.
 l Baseline Start Range: Displays the date range that items in the package are due. This field will 

give you a sense of the timeline for when items in the package should at least get started.
 l Baseline Finish Range: Displays the date range that items in the package were completed. This 

field will give you a sense of the timeline for when items in the package should be completed.

History Tab
 l Created By: Displays the name of the person that created the package.
 l Last Modified By: Displays the name of the person who last modified the package.
 l Last Action: Displays the name of the person who last took action on the package.
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 l Created Date: Displays the date when the package was created.
 l Last Modified Date: Displays the date that the package was last modified.
 l Last Action Date: Displays the date that action was last taken on the package.
 l Action: Displays the action that was taken on the package.
 l User: Displays the name of the user that took the action.
 l Date: Displays the date that the action was taken on the item.
 l Description: Displays the description of the action in more detail.

Item Details
 l Item Icons: The paper clip and comment icons give you the options to view existing attachments 

and comments, and add new ones. General contractors with add/ edit permissions will also see a 
calendar icon that allows them to edit the item date details.

 l Title: Displays the title of the submittal item. Click to open the Submittal Item Details page. If avail-
able, the description icon is displayed; click to view a description of the item as entered by the gen-
eral contractor.

 l #: Displays the submittal item number.
 l Rev #: Displays the submittal item's revision number.
 l Spec Section: Displays the spec section number. The spec section refers to a section number in 

the specifications which itemizes the details of that section; such as Masonry, for example. This is 
usually based on the CSI division.

 l Sub Section: Displays the sub section number. The sub section refers to the subsection number of 
the specifications which itemizes the details of that section. This is usually based on the CSI division 
and its spec section.

 l Category: Displays the category that the submittal item belongs to.
 l Status: Displays the status of the item as assigned by the submittal coordinator. Submittal statuses 

and prefixes are customizable by account administrators, therefore available statuses may vary. 
Below is a description of the default statuses, which may or may not be used by your particular 
account:

 o App - Approved
 o AAN - Approved as Noted
 o FRO - For Record Only
 o ONH - On Hold
 o REJ - Rejected
 o REV - Revise
 o RAR -Revise & Resubmit

 l Submittal Coordinator: Displays the name of the submittal coordinator.
 l Held By: Displays the name of the person(s) in whose court the item is currently in.
 l General Contractor and Subcontractors: If the item was sent to a subcontractor, their name or 

email address (if an external subcontractor) will appear in this field. Internal subcontractors are able 
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to send items to other subcontractors. If this occurs, and neither of these users have taken action on 
the item, both of their names will appear in this field.

 l Submittal Coordinator and Reviewers: If the item was sent for review by the submittal coordinator 
to one or more reviewers, the name or email address (if an external reviewer) of those reviewers will 
appear in this field, as long as they have not yet taken action on the item.

 l Reviewers: A 'Reviewers' link appears in this column when the item has been forwarded for review 
by the submittal coordinator or sub-consultants. Click this link to view a list of all reviewers of the 
item and when their reviews were completed, if applicable.

 l Documents Tab: The Documents tab lists all files that are attached to the item. If the item is in your 
court, you can also add documents of your own.

 l Comments Tab: The Comments tab lists all comments made about the item. If the item is in your 
court, you can also add comments of your own.

Note: If the Hide Comments and Attachments feature is enabled on your account, submittal 
coordinators will see options to show or hide comments in review. With this account setting, com-
ments and attachments added by reviewers and the submittal coordinators are hidden by default 
and the submittal coordinator will have to choose which ones to make visible to the general con-
tractor.

 l Custom Fields Tab: The Custom Fields tab lists the custom fields associated with the item.
 l Revisions Tab: The Revisions tab lists the details of all revisions to the package.

Create Submittal Package Page
This page allows the general contractor (Add/Edit Submittals permission) or the subcontractor (Create Sub-
mittal permission) to create a new submittal package. Individual submittal items must first be added to a pack-
age before they can be sent to the submittal coordinator to start the design review. For instructions, see Create 
Submittal Packages.

At the package level, Submittal Coordinators can edit descriptive information (such as the Submittal Package 
Name or Submittal Package #) when all the items in the submittal package are in review. If some or all of the 
items inside the package are in the court of an Add/Edit team member, then the package will not be available 
for editing.

Note: Submittal Coordinators can edit items in review only if the Allow Submittal Coordinator and Pro-
ject Admin to edit submittal item fields while in review permission has been enabled on the Submittal 
Settings page.

A description of the fields and buttons located on this page are provided  below:

Toolbar Buttons
 l Save: Click to save changes.
 l Cancel: Click to discard changes and return to the Submittal Register page.

Details

Field Descriptions

submittal_settings_page.htm
submittal_settings_page.htm
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 l Project: Displays the project name.
 l Project Number: If available, the project number displays in this field. Project numbers allow you to 

have a unique identifier for each of your projects. Account administrators can add project numbers 
by going to Administration Tools > Projects > Project Settings > Choose a custom field option from 
the Project Number Custom Field drop-down menu.

 l Submittal Package #: Enter the submittal package number in this field.
 l Submittal Package Name: Enter a name for the package in this field.
 l Description: Enter a description of the package in this field.
 l Trade: Enter the trade for which the items in the package will be associated with.

Custom Fields

Custom fields that are available in this section can be edited.

Send for Review 
This page allows general contractors to send items to the submittal coordinator for review. The entire submittal 
package can be sent for review or individual packaged items, if all items of a package are not yet ready to be 
reviewed. For instructions, see:

 l Send Submittal Package for Review
 l Send Individual Items for Review

Fields and Buttons

The fields and buttons on this page are:
 l Send for review: Click this button to send the package for review. When a submitter (General Con-

tractor) clicks the Send for Review button on the Items tab of the Submittal Package Details page, 
the submittal item status will change from "NEW" to "In Review". 

 l Cancel: Click this button to cancel the action and close the Send for review window.
 l Submittal Coordinators: Click this drop-down list to select a submittal coordinator.
 l Review Complete Due Date: Click the calendar icon to select a due date for the submittal package.
 l CC: Select any e-Builder users you would like to copy. Click the blue arrow pointed to the right to 

add their names to the adjacent menu. Repeat this step for all users you wish to copy.
 l CC External Users Via Email: To CC an external user, enter the email address in this field. You 

can also search for a user in the e-Builder contacts list by clicking Lookup. After selecting the 
desired contact from the filter results, click Insert Selected to add it to the CC External Users Via 
Email field.

 l Select folder for external user to attach files: If an external user is selected, a folder for the 
external user to save attached files must be selected. Click this link. The e-Builder Documents folder 
structure displays. Make a folder selection.

 l Message: Enter a message to accompany the submittal package(s).
 l Private: If this option is available to you, select or clear the Private check box to make your com-

ment either private or public.
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Note: The Private Comments feature can be enabled by account administrators. This feature 
allows only users in select roles to view and add private comments. For more information, see 
Manage Private Comments.

 l Selected submittal items: This section lists the items that are being sent to the submittal coordin-
ator.

Update Submittal Item Dates 
While entering items into the system, either via import or individually, the general contractor will include the 
due dates and if applicable the actual date details for the items. These details may change as the submittal pro-
cess proceeds. This page allows you to make the necessary changes to date details. It's important to be accur-
ate about these dates, as reports can be run for these details to help the administrative team identify potential 
bottlenecks.

Filter Submittal Items - Fields and Buttons

The Submittal filter allows you to narrow down the results list to just the items you need to view. This filter 
can be collapsed to increase screen real estate, and then expanded if necessary, by clicking the expand/-
collapse button in the upper-left corner of the page.

The fields and buttons in this section are:
 l Title: Enter the title of a specific submittal item to filter by.
 l Status: Click to choose a specific submittal status to filter by.
 l Number: Enter a specific submittal item number to filter by.
 l Revision: Enter a specific submittal item revision number to filter by.
 l Submittal Package #: Enter a submittal package number to filter by items located in a specific 

page. You can filter on any part of the package number.
 l Responsible Sub/Manufacturer: Enter the name of a sub-consultant or manufacturer to filter by.
 l Custom Field 1: If applicable, click this drop-down arrow or enter a submittal package custom field 

to filter by packages that are associated with a particular custom field.
 l Open: Select to filter for open submittal items, which are those that have been added to a submittal 

package.
 l Draft: Select to filter by draft submittal items.
 l Description: Enter text included in the description of a specific item(s) to filter by.
 l Category: Click to include a specific category of submittal items to filter by.
 l Priority: Click to choose a specific priority of items to filter by.
 l Spec Section: Enter the spec section to filter by. The spec section refers to a section number in the 

specifications which itemizes the details of that section; such as Masonry, for example. This is usu-
ally based on the CSI division.

 l Sub Section: Enter the sub section to filter by. The sub section refers to the subsection number of 
the specifications which itemizes the details of that section. This is usually based on the CSI division 
and its spec section.

manage_private_comments.htm
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 l Custom Field 2: If applicable, click this drop-down arrow or enter a submittal package custom field 
to filter by packages that are associated with a particular custom field.

 l Clear: Click to clear the filter.
 l Filter: Click to filter by entered criteria.

General Contractor Action Buttons

As a general contractor, you should have Add/Edit Submittal permissions, which will give you the ability to 
take the actions implied by each of command buttons listed below.

Update Dates: 

Submittal Items Table
 l Title: Displays the title of the submittal item. Click to open the Submittal Item Details page. If avail-

able, the description icon appears () - click to view a description of the item as entered by the gen-
eral contractor.

 l #: Displays the submittal item number.
 l Rev #: Displays the submittal item's revision number.
 l Package #: Displays the submittal package number that the items belongs to. If a number does 

not display, the item has not yet been added to a package.
 l Spec Section: Displays the spec section number. The spec section refers to a section number in 

the specifications which itemizes the details of that section; such as Masonry, for example. This 
is usually based on the CSI division.

 l Sub Section: Displays the sub section number. The sub section refers to the subsection number 
of the specifications which itemizes the details of that section. This is usually based on the CSI 
division and its spec section.

 l Category: Displays the category that the submittal item belongs to.
 l Status: Displays the status of the item as assigned by the submittal coordinator. Submittal 

statuses and prefixes are customizable by account administrators, therefore available statuses 
may vary. Below is a description of the default statuses, which may or may not be used by your 
particular account:

 o App - Approved
 o AAN - Approved as Noted
 o FRO - For Record Only
 o ONH - On Hold
 o REJ - Rejected
 o REV - Revise
 o RAR -Revise & Resubmit

Send Items to Sub 
This page allows general contractors and internal subcontractors to send items to subs. Please note that only 
e-Builder-licensed subcontractors are able to send items to another sub. For instructions, see:
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 l Send Items to Subcontractor
 l Send Items to another Subcontractor

Fields and Buttons

The fields and buttons on this page are:
 l Send to Sub: Click this button to send item(s) to the subcontractor.
 l Cancel: Click this button to cancel the action and close the Send Item to window.
 l Forward To: This is a required section. The recipient of the submittal item(s) is selected based on 

whether they are an e-Builder user or an external user.
If the recipient is an e-Builder user:

 l  1. Click the Select a Role drop-down list to narrow your search by user role. On users in the 
selected role displays in the Select Recipient drop-down list.

 2. Click the Select Recipient drop-down list to choose a recipient from a list of users.

If the recipient is an external user:

 1. Enter the email address of the person you are forwarding. 
—Or— 
To search for the user in the e-Builder contacts list, click Lookup. The contacts filter displays.

 2. Input all or portions of the requested information, and then click Filter.
 3. Put a check mark next to the contact's name and click Insert Selected.

 l Send Type: 
 o Action Required: Select this option to indicate to the recipient that an action if required of 

them. This option will add the recipient to the Held By list and flag their In My Court list. This 
option is typically used:

 n At the beginning of the review cycle for the general contractor to request submittal doc-
umentation from a subcontractor who is not licensed with e-Builder.

 n At the end of the review cycle for the general contractor to return a submittal to the sub-
contractor author for resubmission.

 o Notify: Select this option to indicate to the recipient that they are only being notified, but no 
action is required of them. This option is typically used at the end of a review cycle to notify 
affected subcontractors that a submittal has been returned without a need for resubmission.

 l Respond By: This field is only applicable if the Action Required option is selected. Click the cal-
endar icon to select a response date.

 l CC: Select the e-Builder users you would like to copy. You can select user roles or individual users. 
Click the blue arrow pointed to the right to add their names to the adjacent box. Repeat this step for 
all users you want to copy.

 l CC External Users Via Email: To CC an external user, enter the email address in this field. You 
can also search for a user in the e-Builder contacts list by clicking Lookup. After selecting the 
desired contact from the filter results, click Insert Selected to add it to the CC External Users Via 
Email field.
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 l Select folder for external user to attach files: If an external user is selected, a folder for the 
external user to save attached files must be selected. Click this link. The e-Builder Documents folder 
structure displays. Make a folder selection.

 l Message: Enter a message to accompany the submittal item(s).
 l Private: If this option is available to you, select or clear the Private check box to make your com-

ment either private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature 
allows only users in select roles to view and add private comments. For more information, see 
Manage Private Comments.

 l Selected submittal items: This section lists the items that are being sent to the subcontractor.

Forward for Review 
This page allows submittal coordinators and e-Builder licensed sub-consultants to forward items to reviewers. 
It's important to note that t here are two types of forwards. You can forward to simply notify the recipient of the 
item or require action from them. Notifying is simply an FYI because the item is not placed in their court. Requir-
ing action places the item in the recipient's court. For instructions, see one of the following:

 l Forward Items for Review
 l Forward Items to Other Reviewers

Fields and Buttons

The fields and buttons on this page are:
 l Forward for Review: Click to forward item(s) for review.
 l Cancel: Click to cancel the action and close this window.
 l Forward To: Only e-Builder licensed users appear in the list of available users. Select the users to 

forward to and then click the right directional arrow to add them to the adjacent box. To forward to 
external users, enter their email address in the subsequent and/or Enter external user (email).

 l Send Type: 
 o Action Required: Select to require the recipient to take action on the item. This will place the 

item in their court, which indicates that they have a responsibility to take action on the item.
 o Notify: Select this ratio button to indicate to the recipient that they are only being notified, but 

no action is required of them.
 l Respond By: This field is only applicable if the Action Required option is selected. Click the cal-

endar icon to select a response date.
 l CC: Select any e-Builder users you would like to copy. Click the blue arrow pointed to the right to 

add their names to the adjacent menu. Repeat this step for all users you wish to copy.
 l CC External Users Via Email: To CC an external user, enter the email address in this field. You 

can also search for a user in the e-Builder contacts list by clicking Lookup. After selecting the 
desired contact from the filter results, click Insert Selected to add it to the CC External Users Via 
Email field.

manage_private_comments.htm
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 l Select folder for external user to attach files: If an external user is selected, a folder for the 
external user to save attachments to must be selected.

 l Message: Enter a message to accompany the submittal item(s).
 l Private: If this option is available to you, select or clear the Private check box to make your com-

ment either private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature 
allows only users in select roles to view and add private comments. For more information, see 
Manage Private Comments.

 l Selected submittal items: This section lists the items that are being forwarded for review.

Add Comments
The Add Comment page allows users of the Submittal module to add comments to individual submittal items. 
As a subcontractors, you can add comments as long as it is in your court. Once the item is sent off to another 
resource, you will no longer be able to add comments. 

The following topics will assist you in adding comments:
 l Add Comments to Submittal Items 
 l Show/ Hide Comments from Review (Submittal Coordinators)

Fields and Buttons

The fields and buttons on this page are:
 l Save: Click to save changes.
 l Check Spelling: Click to check the spelling of text fields.
 l Cancel: Click to discard changes. All unsaved changes will be lost.
 l Submittal Item: Displays name of the submittal item.
 l Comment: Enter your comment in this field.
 l Private: Displays only if you are in a role that has the permissions to add private comments. Select 

to make your comment private. Only users in roles that are able to see private comments will be able 
to view this message. If the submittal coordinator decides to include a Private comment in the final 
package to construction (Shown in Review), then the comment's visibility may automatically be 
changed to Public. For more information on this setting, see Manage Private Comments.

 l Attach Documents: Click to attach a document to your comment.
 l File Name: This column displays the name of the attached file.
 l Attached By: This column displays the name of the person that attached the file.

Comments - Columns
 l Private: A check mark in this column indicates that the comment is private which means that only 

users in roles that have permission to view private comments will be able to view this comment.
 l In Review: This column is displayed only if the Hide Comments and Attachments feature is enabled. 

A check mark in this column indicates that the comment will be visible to the GC in review. For 
instructions on showing or hiding comments from review, see Show/Hide Comments from Review.

manage_private_comments.htm
manage_private_comments.htm
submittal_settings_page.htm
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 l Comment: This column displays the existing comment. From here you can make comments private 
or public and show or hide the comment from review, if these settings are enabled on the account. 
Click the title of the file to open or download it.

Submit to GC
This page allows subcontractors with Create Submittal permissions to kick off the review process by sending 
submittal documentation to the general contractors directly. This saves the GC the effort of creating all sub-
mittal items and requesting documentation through the Send to Sub action.

Submit to GC - Fields and Buttons

The fields and buttons located on this page are:
 l General Contractor: This is a required field. The dropdown list of individuals who can receive the sub-

mittal is determined by the general contractor role identified in the Project Submittal Settings under 
Subcontractor Options.

 l GC Review Complete Due Date: This is a required field. The date is pre-filled based on the offset time-
frame identified in the Project Submittal Settings under Subcontractor Options, but can be modified if 
needed. Click the calendar icon to select a response date.

 l CC Roles: Select the e-Builder roles you would like to copy. Click the blue arrow pointed to the right to 
add their names to the adjacent box. Repeat this step for all users you want to copy.

 l CC Users: Select the e-Builder users you would like to copy. You can select user roles or individual 
users. Click the blue arrow pointed to the right to add their names to the adjacent box. Repeat this step 
for all users you want to copy.

 l CC External Users Via Email: To copy an external user:
 o Enter the email address in the CC External Users Via Email field. 

—Or— 
To search for the user in the e-Builder contacts list, click Lookup. The contacts filter displays.

 o Input all or portions of the requested information, then click Filter.
 o Put a check mark next to the contact's name and click Insert Selected.
 o If the external user is an e-Builder contact, use your keyboard to auto-fill the desired email 

address. Begin typing the recipient's name or email address then use the arrows to highlight the 
email of choice, and then click Tab to make the selection.

 l Message: Enter a message to accompany the submittal item(s).
 l Private: If this option is available to you, select or clear the Private check box to make your comment 

either private or public.

Note: The Private Comments feature can be enabled by account administrators. This feature allows 
only users in select roles to view and add private comments. For more information, see Manage Priv-
ate Comments.

 l Selected submittal items: This section lists the items that are being sent to the subcontractor.

manage_private_comments.htm
manage_private_comments.htm
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Reopen a Submittal Package
If a submittal package was closed in error or it is later determined that it should be open, it can be reopened. 
Reopening a submittal package will return it to the Open status.

To reopen a closed submittal package
 1. Go to the Submittal Packages page for the project.

For more information, see the Access Submittals page for instructions on how to access the Sub-
mittal Packages page.

Tip: Use the Filter Submittal Packages section to narrow filter results to show only closed sub-
mittal packages. This will help you access the desired submittal package more easily. In the Pack-
age Status field, select the Closed check box and then click Filter.

 2. Click the title or the package # of the submittal package you want to reopen.
The Submittal Package Details page is displayed.

 3. Click Re-Open. The Add Comment popup is displayed.
 4. Enter a comment, if required.
 5. Click Re-Open to confirm. The submittal package is now re-opened.

To reopen a closed submittal package by re-opening a submittal package item in it

Note: Re-opening a submittal item will also re-open the submittal package that it is part of.

 1. Go to the Submittal Packages page for the project.
For more information, see the Access Submittals page for instructions on how to access the Sub-
mittal Packages page.

Tip: Use the Filter Submittal Packages section to narrow filter results to show only closed sub-
mittal packages. This will help you access the desired submittal package more easily. In the Pack-
age Status field, select the Closed check box and then click Filter.

 2. Click the title or the package # of the submittal package you want to reopen.
The Submittal Package Details page is displayed.

 3. Click on a submittal item to view the Submittal Item Details page. 
 4. Click Re-Open. The Add Comment page is displayed.
 5. Enter a comment, if required.
 6. Click Re-Open to confirm. The submittal package and submittal item is now re-opened.
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